Notice

The information contained in this document is subject to change without notice.

Agilent Technologies makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. Agilent Technologies shall not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material.

Warranty

A copy of the specific warranty terms that apply to this software product is available upon request from your Agilent Technologies representative.

Restricted Rights Legend

Use, duplication or disclosure by the U. S. Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 for DoD agencies, and subparagraphs (c) (1) and (c) (2) of the Commercial Computer Software Restricted Rights clause at FAR 52.227-19 for other agencies.

Agilent Technologies
395 Page Mill Road
Palo Alto, CA 94304 U.S.A.

Copyright © 2002, Agilent Technologies. All Rights Reserved.

Acknowledgments

PostScript is a registered trademark of Adobe Systems Incorporated.

Motif is a trademark of the Open Software Foundation.

UNIX is a registered trademark of the Open Group.

Netscape is a trademark of Netscape Communications Corp.

QuestAgent search engine copyright © 2000, J Objects.

FLEXlm is a trademark of Globetrotter Software, Incorporated.
Contents

1 Before You Install/Quick Install
   Pre-Installation Guidelines................................................................. 1-1
   Installation Procedure Overview....................................................... 1-3
   Quick Installation .............................................................................. 1-4

2 Requirements on UNIX Systems
   Installing the Required HP-UX 10.2 Patches..................................... 2-2
      Important Patch Required on HP-UX 10.2 Systems.......................... 2-2
      Additional Patches Required for HP-UX 10.2................................. 2-3
   Installing Required IBM AIX 4.3 Patch............................................ 2-4
   IBM AIX Memory Problems Simulating Very Large Designs............... 2-4
   HP-IB and GPIB Interfaces............................................................... 2-5
      HP-UX 10.2.................................................................................... 2-5
      HP-UX 11.0 and IBM AIX 4.3......................................................... 2-5
   Sun Solaris 7.0, 8.0 or Sun OS 5.7, 5.8............................................. 2-6
   Checking Memory............................................................................... 2-6
      SUN Workstation........................................................................... 2-6
      HP Workstation............................................................................. 2-6
   Checking Disk Space ......................................................................... 2-7
   Checking Swap Space ....................................................................... 2-8
   Checking the Operating System....................................................... 2-8

3 Installation Procedures
   Installing to a Single Disk Partition or Directory................................ 3-1
   Starting Advanced Design System..................................................... 3-13
   Installing to Multiple Disk Partitions or Directories............................ 3-14
   Using Multiple ADS Versions........................................................... 3-15
      Procedure....................................................................................... 3-15

4 Setting Up Licenses on UNIX Systems
   Installing the Codewords.................................................................. 4-1
      Step 1: Save the Codeword File to a license.lic File......................... 4-3
      Step 2: Edit the license.lic File...................................................... 4-3
      Step 3: Place license.lic Copy on the SERVER Machine(s)................. 4-8
      Step 4: Start lmgrd on the SERVER Machine(s)............................... 4-8
      Step 5: Configure the User’s Environment to Access Licenses from the SERVER Machine(s)......................................................... 4-10
   Using a UNIX-to-PC Floating License................................................ 4-12
   Automating FLEXlm License Manager Startup.................................... 4-13
   Special Licensing Needs.................................................................... 4-14
   Using FLEXlm Options..................................................................... 4-14
Configuring FLEXlm ................................................................. C-4
Installing Licensed Software......................................................... C-4
License Servers and Hostids ........................................................ C-5
License and lmgrd Files .............................................................. C-5
Administration Tools ................................................................. C-5
Options Files ................................................................................ C-5
Notes for Users........................................................................... C-6

D Using Remote Simulation

Setting up Your Simulation Server (Host) Computer ................................ D-1
  Setting up a UNIX Server .......................................................... D-1
  Setting up a PC Server ............................................................. D-3
Setting up a UNIX Client (Local Computer) ...................................... D-4
User Preferences ........................................................................... D-5
  Multiple Servers ...................................................................... D-5
  Scripting ................................................................................ D-5
Error Messages ............................................................................ D-6
  Error Message 1 ...................................................................... D-6
  Error Message 2 ...................................................................... D-6
Ending Remote Operation .......................................................... D-7
Remote Simulation Restrictions .................................................. D-7
Defining the EMX Daemon Remote Address ................................. D-7
Using LSF Remote Simulation .................................................... D-8
  LSF Requirements ................................................................ D-8
  Setting Up LSF and ADS ........................................................ D-10
  Using LSF in ADS ................................................................. D-16

Index
Chapter 1: Before You Install/Quick Install

This chapter contains brief pre-installation guidelines for installing Advanced Design System on UNIX® systems, an installation procedure overview, and quick installation instructions. Please take a look at this chapter before starting to install Advanced Design System software.


Pre-Installation Guidelines

• Read the guidelines listed in Chapter 2, Requirements on UNIX Systems. This will tell you how much RAM, disk space, and other requirements are needed to run Advanced Design System.

• New Codewords for ADS 2002: ADS 2002 requires new codewords. Earlier versions allowed cross-licensing with Series IV and MDS, which ended with this release. You must install new codewords to run ADS 2002. The name of the license file has changed with ADS 2002 and is now called license.lic.

You need to obtain FLEXlm licenses or codewords for Advanced Design System before you will be able to use the software. Codewords can be requested on the Web at:

http://contact.tm.agilent.com/tmo/hpeesof/forms/codereqform.html

For those who do not have Web access, a Codeword Request form is included with your installation media. Please fill it out completely and fax it to the number indicated on the form. You may also contact Agilent EESof Business Support at 1-800-507-6274 if you have trouble.

• Important: You can retain earlier installations of Advanced Design System (such as Version 2001) and 2002 in separate directories on the same machine, but you cannot install Version 2002 over a previous Advanced Design System installation. (This also applies to a Beta 2002 version.) If you decide to delete
Before You Install/Quick Install

the installation of a previous version, you should first copy any needed projects, customized configuration files, or other data that is saved there to a temporary directory. Make sure to retain your previous license.dat file, which is located in <install_dir>/licenses. Then delete the hpeesof directory (located in your home directory) and everything underneath it. Next, copy all needed files from your temporary directory to the appropriate locations in the new Version 2002 installation directory. For more information on running multiple ADS versions, refer to "Using Multiple ADS Versions" on page 3-15 in Chapter 3.

• Install using a login that has permissions to write to the disk(s) you want to install Advanced Design System to.

• You do not need to install Advanced Design System software as root, although you may need root privileges to mount and unmount the installation CD-ROMs. If installed as root, all ADS files should have at least read permission for all users.

• You can install all components shown in the installation program, but you will only be able to run those you have purchased licenses for.

• You can re-run the installation program to install components you chose not to install the first time through.
Request codewords.

Insert installation CD-ROM DISK 1 in UNIX CD-ROM drive and mount.

Change directory to the CD-ROM and run Setup:
```bash
cd /cdrom/UNIX
./SETUP.
```

Setup program loads installation program and indicates where to run it from. Run it as instructed.

Agilent EEsof Installation Manager starts. Carefully follow the on-screen instructions.

After installation, place your codewords in a file named license.lic and start FLEXlm.

Run Advanced Design System.
Quick Installation

This section provides quick step-by-step installation instructions. Some steps contain references to other sections of this manual for more details.

To install Advanced Design System on UNIX systems:

1. Request and obtain codewords from Agilent EEsof. (Refer to page 1-1.)

2. Log onto the system using an account that has permissions to write to the disk you want to install to.

3. Mount installation CD-ROM labeled DISK 1. (Refer to step 2 in “Installing to a Single Disk Partition or Directory” on page 3-1.)

4. Change to the UNIX sub-directory on the mounted CD-ROM. For example:

   cd /cdrom/UNIX

   For more details, refer to step 3 in “Installing to a Single Disk Partition or Directory” on page 3-1.

5. Enter the following command:

   ./SETUP*

   For more details, refer to step 4 in “Installing to a Single Disk Partition or Directory” on page 3-1.

6. The SETUP script will prompt you to enter the full path to the directory where you would like Agilent ADS Products installed (default = /usr/local/ads2002). If the directory does not exist, the program will create it. Then it will load the Agilent EEsof Installation Manager program to

   <install_directory>/install/bin

7. Once the Installation Manager program has been installed, instructions for starting the installation program will be displayed. Change to the directory indicated, then enter: ./install.

8. The Installation Manager starts and a Welcome tab appears. Click Next.

9. From the Platforms tab that appears, choose the appropriate platform and click Next.

10. From the Setup tab that appears, you can choose to do a Typical, Complete, or Custom installation. Make your choice and click Next. The Components tab appears.
• **Typical** installs all ADS Design Suites, related modules (such as Momentum electromagnetic simulator, Digital Filter Designer, Vendor Component Libraries, etc.), examples and documentation. The disk space required is shown on the screen.

  Typical does not install ADS Design Libraries (such as W-CDMA, Digital TV, or GSM), DesignGuides, nor a few specialized tools (such as HDL Cosimulation or RF Compiler). For a list of what is installed with a Typical Installation, refer to “Typical Installation List of Components” on page 3-5.

• **Complete** installs all Advanced Design System suites, modules, examples, and documentation. The disk space required is shown on the screen.

• **Custom** allows you to choose the specific ADS components you want to install. More about the Custom installation follows.

  (For more information on choosing Typical, Complete, or Custom, refer to steps 11 through 14, in the section “Installing to a Single Disk Partition or Directory” on page 3-1.)

11. For Custom Installations only: Choose the specific components you want to install. Scroll as needed to find components, as there are more than 25 options (you may not have purchased some of the options). Click on a component name to see a description. Make sure to check all boxes of components you wish to install. Choose Next to continue.

12. From the Options tab that appears, you choose options related to Documentation and ADS Examples. For examples, you can choose the complete set of examples or just the application(s) you’re interested in. Choose the Description button next to each for more information. If you do not select one of the Online Documentation options, no online manuals or help will be installed. Make your choice(s) and click Next.

13. From the Summary tab that appears, you can review the choices you have made. Click Back to go back and make changes, Next to proceed with the installation, or Cancel to exit the installation program.

14. The Install tab is displayed and files are copied to your system.

15. If you chose to install Online Documentation and/or Vendor Component Libraries, you will be prompted to unmount Disk 1 and mount Disk 2, as necessary. Refer to steps 16 through 18 in the section “Installing to a Single Disk Partition or Directory” on page 3-1 for help with mount and unmount.
Before You Install/Quick Install

16. When Installation is complete, unmount the currently mounted CD-ROM. (Refer to step 22 in the section "Installing to a Single Disk Partition or Directory" on page 3-1.)

17. When you are finished, choose Done.

18. Configure the user accounts that will run Advanced Design System, as follows:

C-Shell Users:

Add the following at the end of $HOME/.cshrc:

```bash
setenv HPEESOF_DIR <install_directory>
setenv AGILEESOF_LICENSE_FILE <path_to_license_file>
set path = ( . $HPEESOF_DIR/bin $path )
```

Bourne or Korn Shell Users:

Add the following at the end of $HOME/.profile:

```bash
HPEESOF_DIR=<install_directory>
AGILEESOF_LICENSE_FILE=<path_to_license_file>
PATH=.:$HPEESOF_DIR/bin:$PATH
export HPEESOF_DIR AGILEESOF_LICENSE_FILE PATH
```

If you will run Advanced Design System from a remote computer and you want the display to appear on your local machine, you will need to set the DISPLAY environment variable:

```bash
setenv DISPLAY <my_hostname>:0.0 (C-Shell)
DISPLAY = <my_hostname>:0.0 (Korn Shell, Bourne Shell)
export DISPLAY
```

19. For more information, refer to step 23 in the “Installing to a Single Disk Partition or Directory” on page 3-1.

20. Place your FLEXlm licenses (or codewords) in a file named license.lic. Make sure the SERVER and VENDOR lines are configured correctly. (Refer to Chapter 4, Setting Up Licenses on UNIX Systems).

21. Place the license.lic file in the licenses sub-directory of your Advanced Design System installation directory. Start FLEXlm to enable your codewords. (Refer to Chapter 4, Setting Up Licenses on UNIX Systems.)
You are now ready to run Advanced Design System. Once FLEXlm is running, and your user account is configured, you can start Advanced Design System by entering:

`hpads`

**Note**  ADS Version 2002 is equivalent to ADS 190, 1.9 or 2.0. These internal version numbers for ADS 2002 appear in a few places, such as from Help > About Advanced Design System > Version and in the licensorlic file.
Chapter 2: Requirements on UNIX Systems

To successfully install and run Advanced Design System software on UNIX systems, you need the hardware and software specified in the following system checklist.

Note The software versions indicated below are those that have been tested and are supported. Operating system versions not listed are not officially supported.

Table 2-1. Computer System Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>SunOS</th>
<th>HP 9000-700</th>
<th>IBM AIX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>SunOS 5.7 (Solaris 7.0 using 5.6 build) or SunOS 5.8 (Solaris 8.0 using 5.6 build) Note: Sun operating systems are not supported on Intel-compatible chips.</td>
<td>HP-UX 10.2x or HP-UX 11.0 For HP-UX 10.2, you must have the latest patches installed. Refer to the section “Important Patch Required on HP-UX 10.2 Systems” on page 2-2 in this chapter.</td>
<td>IBM AIX 4.3 or higher</td>
</tr>
<tr>
<td>Displays</td>
<td>High-resolution color only.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RAM</td>
<td>128 MB RAM recommended minimum, additional RAM will improve performance.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Swap Space</td>
<td>300 MB recommended minimum, increased swap space may be required for larger designs.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web Browser</td>
<td>ADS documentation is HTML-based and displayed via browser. Netscape version 4.5 or higher is required. ADS installs the current Netscape version, but if you have an older unsupported version, make sure it's not in your path ahead of the ADS installation.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hard Disk Space</td>
<td>335 MB for a minimum installation, 1.7 GB for a typical installation, and 2.7 GB for a complete installation.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Security Device</td>
<td>An Advanced Design System software codeword is locked to an individual computer ID number.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Installing the Required HP-UX 10.2 Patches

Following is important information about the patches required to successfully run Advanced Design System under HP-UX 10.2.

Important Patch Required on HP-UX 10.2 Systems

If you are running Advanced Design System on HP-UX 10.2 systems and you do not have the aCC or HP aC++ compiler installed, you must install the following HP-UX patch to successfully run the simulator.

PHSS_17872 10.x HP ac++ runtime library components

The patch is needed, but patch numbers change over time. Since this patch affects older systems, you may already have this patch installed. At the time of this publication, the patch number is correct, but this number may change. When
obtaining patches, please search for the content needed or for cross-references from obsolete patch numbers to the latest patch numbers.

If the runtime library is missing, the following error message will appear:

crt0: ERROR couldn’t open /usr/lib/aCC/dld.s1 errno:000000002

For HP-UX 11 and newer 10.2 ACE releases of HP-UX that come on new machines, this runtime library is a part of the standard operating system core installation.

Additional Patches Required for HP-UX 10.2

For installations of Advanced Design System under HP-UX 10.20, the latest version of HP-UX patches or the HP-UX Extension Software CD-ROM must be installed. This CD-ROM is available to anyone who currently holds an active HP-UX software support contract. Current patches are also available at the HP-UX web site, as follows:

http://us-support.external.hp.com

Following are the suggested patches. The patch numbers are current at the time of this manual printing, but they periodically change. Make sure you install the latest versions.

<table>
<thead>
<tr>
<th>Description</th>
<th>Patch ID Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>B.10.00.00.AA Xserver cumulative patch</td>
<td>PHSS_11398</td>
</tr>
<tr>
<td>B.10.00.00.AA PEX 5.1/Starbase/Hardcopy Runtime patch</td>
<td>PHSS_11399</td>
</tr>
<tr>
<td>B.10.00.00.AA libc cumulative patch</td>
<td>PHCO_12448</td>
</tr>
<tr>
<td>B.10.00.00.AA libc header file cumulative patch</td>
<td>PHCO_9261</td>
</tr>
<tr>
<td>B.10.00.00.AA VM, kernel stack overflow,VxFS,LVM,serialize()</td>
<td>PHKL_13237</td>
</tr>
<tr>
<td>B.10.00.00.AA SoftBench C.05.25 Cumulative Patch</td>
<td>PHSS_10575</td>
</tr>
<tr>
<td>B.10.00.00.AA dld.s1(5) cumulative patch</td>
<td>PHSS_10765</td>
</tr>
<tr>
<td>B.10.00.00.AA LIBCL cumulative patch</td>
<td>PHSS_10766</td>
</tr>
<tr>
<td>B.10.00.00.AA HP C++ core library components (A.10.26)</td>
<td>PHSS_10767</td>
</tr>
<tr>
<td>B.10.00.00.AA ld(1) and som tools cumulative patch</td>
<td>PHSS_11669</td>
</tr>
<tr>
<td>B.10.00.00.AA HP C++ (A.10.32) to fix numerous defects</td>
<td>PHSS_13374</td>
</tr>
<tr>
<td>B.10.00.00.AA ANSI C compiler cumulative patch</td>
<td>PHSS_13421</td>
</tr>
</tbody>
</table>

You can check to see which patches you have installed by running:
Requirements on UNIX Systems

/installables

Installing Required IBM AIX 4.3 Patch

The following patch will fix problems associated with simulation on the IBM AIX 4.3 platform. You must install it to successfully run the simulator. It is only required on AIX 4.3 (not 4.2). Contact IBM for information on obtaining this patch.

<table>
<thead>
<tr>
<th>Description</th>
<th>Patch ID Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM AIX 4.3 patch “Infinite loop/core dump in signal handling”</td>
<td>IX74068</td>
</tr>
</tbody>
</table>

IBM AIX Memory Problems Simulating Very Large Designs

The default AIX memory limits may result in an out-of-memory error when simulating very large designs. One example is the following digital TV 64 QAM design:

```
DTV_DVBSystem_prj\ DsnDTV_DVBSystem_Hier64QAM.dsn
```

Generally the default memory setting will be acceptable. However, if you receive an error, you may want to change your AIX settings, as described next.

Caution  If your system is shared by several users or is low in system resources, such as RAM, you should not use this script. If an executable is allowed to use more memory and your system runs out of memory, an AIX system will crash.

On AIX systems, to enable a larger memory limit:

1. Login as root.

2. Edit the /etc/security/limits file to change the default values of system attributes limits to -1 (unlimited). You can change all of the default values to be -1. The most important attributes related to memory usage include data, rss and stack.

3. Under the <installation directory> bin directory is a script named BmaxData.ksh. This script changes the data segment size an individual
executable can use on an AIX system. The following is an example of using this script:

```
cd $HPEESOF_DIR/bin
./BmaxData.ksh ./hpeesofsim 4
```

For more information, run this script without any arguments.

**HP-IB and GPIB Interfaces**

Following are complete lists of HP-IB and GPIB interfaces that are supported for this version of Advanced Design System under different versions of the UNIX operating system.

**HP-UX 10.2**

The supported HP-IB and GPIB hardware and software interface kits that can be used with the HP-UX 10.2 operating system are:

<table>
<thead>
<tr>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hewlett-Packard LAN/HP-IB Gateway Interface/ SICL drivers*</td>
<td>E2050A Opt AG1</td>
</tr>
<tr>
<td>Hewlett-Packard HP-IB PCI card / SICL drivers*</td>
<td>E2078A</td>
</tr>
<tr>
<td>Hewlett-Packard HP-IB EISA card / SICL drivers*</td>
<td>E2070C</td>
</tr>
<tr>
<td>Hewlett-Packard High-Speed HP-IB card / SICL drivers*</td>
<td>E2071D</td>
</tr>
<tr>
<td>National Instruments EISA GPIB card / NI-488.2M drivers</td>
<td>776920-01</td>
</tr>
</tbody>
</table>

*When installing HP SICL drivers, you must use `swinstall` to install these drivers. For more information, refer to the SICL documentation.

**HP-UX 11.0 and IBM AIX 4.3**

The supported HP-IB hardware and software interface kit that can be used with the above-listed operating systems is:

<table>
<thead>
<tr>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hewlett-Packard LAN/HP-IB Gateway Interface</td>
<td>E2050A</td>
</tr>
</tbody>
</table>
Requirements on UNIX Systems

**Sun Solaris 7.0, 8.0 or Sun OS 5.7, 5.8**

The supported HP-IB and GPIB hardware and software interface kits that can be used for the above-listed Sun operating system versions are:

<table>
<thead>
<tr>
<th>Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hewlett-Packard LAN/HP-IB Gateway Interface</td>
<td>E2050A</td>
</tr>
<tr>
<td>National Instruments PCI GPIB card / NI-488.2M drivers</td>
<td>777462-01</td>
</tr>
<tr>
<td>National Instruments sBus GPIB/TNT card / NI-488.2M drivers</td>
<td>776789-01</td>
</tr>
</tbody>
</table>

**Checking Memory**

A minimum of 128 MB of memory on your system is recommended. More memory results in better overall system performance.

**SUN Workstation**

To check the amount of memory on your system, enter the following command at a UNIX prompt:

```
/etc/dmesg | more (SunOS 5.x etc.)
/usr/bin/dmesg | more (Solaris 7.0/ 8.0)
```

Look for the “avail mem=” and “mem=” lines.

This command lists the messages displayed during the last boot of the system.

**HP Workstation**

To check the amount of memory on your system, enter the following command at a UNIX prompt:

```
/etc/dmesg
```

Look for the “Memory Information” line.

By default, HP-UX limits a single application’s memory allocation to 65 megabytes. To allocate more memory for a single process, use `sam` (System Administration Manager) to reconfigure the kernel parameters maxdsiz, maxtsiz and maxssiz to maximize the system’s ability to allocate and use the available memory resources.
For example, if your system has 128 MB of physical RAM and 500 MB of swap space, you would need to adjust the maxdsiz and maxtsiz kernel parameters to:

\[ \text{<Total RAM>} + \text{<Total Swap>} = 128 + 500 = 628 \text{ MB} \]

The maxssiz kernel parameter should be adjusted to approximately 12% of the maxdsiz value, or its maximum.

**IBM AIX Workstation**

To check the amount of memory on your system, do the following:

1. At the System prompt, type `smit` and press return.
2. From the Systems Management Menu, select **System Environments**.
3. Select **Change/Show Characteristics of Operating System**. Configuration information is displayed, including the amount (in kilobytes) of memory with the heading Amount of usable physical memory in kilobytes.

**Checking Disk Space**

The amount of disk space required depends on the Advanced Design System products that you wish to install. Approximately 1.1 GB of disk space is required to install all Advanced Design System products.

To check disk space, at the prompt enter the following command appropriate to the workstation you are using:

<table>
<thead>
<tr>
<th>Workstation</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP UX 10.x, 11</td>
<td>bdf</td>
</tr>
<tr>
<td>SunOS 5.x</td>
<td>df</td>
</tr>
<tr>
<td>Solaris 7.0/8.0</td>
<td>df -k</td>
</tr>
<tr>
<td>IBM AIX</td>
<td>df -k</td>
</tr>
</tbody>
</table>

The amount of available disk space is displayed.

**Note** ADS requires at least 20-30 MBytes of free disk space under /tmp and var/tmp to work properly.
Requirements on UNIX Systems

Checking Swap Space

The recommended minimum swap space is 300 Mbytes. Very large designs, and designs with many hierarchical levels, could require more. To check the current amount of swap space on your system, enter one of the following:

/etc/swapinfo -t (HP)
/usr/etc/pstat -s (SunOS 5.x)
/usr/sbin/swap -s (Solaris 7.0/ 8.0)
lsps -a (IBM AIX)

If you need to increase the amount of swap space available for your system, refer to the appropriate system administration manual for your system.

Checking the Operating System

To determine the version that you are currently running, at the system prompt type:

uname -r (All UNIX platforms)
Chapter 3: Installation Procedures

This chapter contains detailed instructions for installing Advanced Design System on UNIX workstations. For a brief procedure, refer to “Quick Installation” on page 1-4. The Advanced Design System directory structure allows the top-level directory (installation directory) to be user-specified. The environment variable HPEESOF_DIR is used to specify this installation directory for use within the Advanced Design System environment.

The Agilent EEsof Installation Manager program will allow you to install everything contained on the installation CD-ROMs (Complete installation) or to choose only the portions you want to install (Custom installation).

Note For last-minute installation information, view the file readme.htm, located on the UNIX Disk 1 or PC Setup disk. For last-minute program and documentation information, refer to the Release Notes document on our website at http://www.agilent.com/eesof-eda.

Installing to a Single Disk Partition or Directory

Note If you installed a pre-release Beta version of Advanced Design System, you should remove it before loading this release. Remove the HPEESOF subdirectory (which is located under your HOME directory) and everything underneath it.

Agilent EEsof recommends that you install the entire contents of the Advanced Design System CD-ROMs (approximately 1.3 GB) to a single disk partition. If you do not have enough available disk space in a single disk partition, and want to spread the installation across disk partitions, please refer to the section “Installing to Multiple Disk Partitions or Directories” on page 3-14.

To install Advanced Design System software:

1. Request and obtain codewords from Agilent EEsof (Refer to page 1-1).
2. Log onto the system using an account that has write privileges to the disk you want to install to.
Installation Procedures

3. Mount the Advanced Design System UNIX Program CD-ROM (Disk 1). Mounting a CD-ROM file system on a UNIX system requires root or super-user privileges on most UNIX systems. If you are running Solaris 7.0/8.0, the CD-ROM will be mounted automatically for you by the Solaris Volume Manager Daemon (vold), if it is running. You can check if the CD-ROM is mounted by running the mount command without any arguments.

**Note** If you are running Solaris 7.0/8.0 and the Disk 1 CD-ROM has been mounted by vold, you can skip to step 4.

The typical mount point, or directory, for a CD-ROM is /cdrom. This may be different on your UNIX system. The mount point directory must exist before you can mount the CD-ROM. To create a /cdrom directory, type:

```
mkdir /cdrom
```

To mount the first Program CD-ROM (Disk 1), run the command for your system:

```
mount -rt cdfs /dev/dsk/c201d2s0 /cdrom (HP-UX 11)
mount /dev/dsk/c0t2d0 /cdrom (HP-UX 10.20)
mount -rt hsfs /dev/sr0 /cdrom (SunOS 5.x)
mount -v cdrfs -r /dev/cd0 /cdrom (IBM AIX)
```

If your Solaris 7.0/8.0 system is not running vold, you can mount the CD-ROM using the following command:

```
mount -F hsfs -r /dev/dsk/c0t6d0s0 /cdrom (Solaris 7.0/8.0)
```

Once the Program CD-ROM (Disk 1) is mounted, exit from being root before completing the rest of the installation procedure if you do not want to install as root.

4. Change directory to the UNIX subdirectory on the Program CD-ROM.

```
cd /cdrom/UNIX
```

**Note** If you are running Solaris 7.0/8.0, and the vold daemon is active, type the following command:

```
cd /cdrom/cdrom0/UNIX
```

3-2 Installing to a Single Disk Partition or Directory
Solaris 7.0/8.0 users not installing as the user root will also need to set the umask command, as follows:

```bash
umask 000
```

5. Start the installation program using the command for your system:

```
./SETUP*1 (HP-UX)
./SETUP (SunOS 5.x, Solaris 7.0/8.0, IBM AIX)
```

Note that the Sun File Manager is not recommended to invoke SETUP.

---

**Note** If you are running Netscape, or another program that uses a lot of color resources, you should shut it down before starting the Agilent EEsof Installation Manager.

6. You are prompted to enter the full path to the directory where you would like Advanced Design System software to be installed. The default directory is `/usr/local/ads2002`. Press **Enter** to accept the default or enter your own path and press **Enter**.

**Note** If the specified directory doesn’t exist, it will be created for you.

7. The installation directory you have selected is shown, along with the available disk space on the disk partition that contains this directory. If you want to keep the installation directory shown, enter **y** (for yes). If you want to change the installation directory, enter **n** (for no).

8. The Agilent EEsofInstaller is loaded. Then a message appears indicating the directory that you must change to and a command that you must enter to start the installation program. The following is an example:

```
cd /usr/local/ads2002/install/bin
./install
```

9. The Agilent EEsof Application Installation window appears, with the Welcome tab active. This tab allows you to confirm your installation directory choice.
Choose **Next** to proceed. Choose **Cancel** to exit the installation program.

10. The **Platforms** tab becomes active. Confirm or select the platform you want to install, then choose **Next**.

**Note** If you want to install the executables for more than one platform, you will need to re-run the Agilent EEsof Installation Manager program for each platform.

11. The **Setup** tab becomes active. This tab allows you to choose from three types of installations:

- **Typical** installs all ADS Design Suites, related modules (such as Momentum electromagnetic simulator, Digital Filter Designer, Vendor Component Libraries, etc.), examples and documentation. The disk space required is shown on the screen.

  Typical does not install ADS Design Libraries (such as W-CDMA, Digital TV, or GSM), DesignGuides, nor a few specialized tools (such as HDL Cosimulation or RFIC Dynamic Link). See Table 3-1 in this chapter for a list of the components installed in the Typical installation.

- **Complete** installs all Advanced Design System suites, modules, examples, and documentation. The disk space required is shown on the screen.

- **Custom** allows you to choose the specific ADS components you want to install. Scroll as needed to find components. See Table 3-2 in this manual for a list of components you can install. The disk space required is shown on the screen.

Choose an installation type. The Components tab appears.

**Note** While you choose here which ADS features you want to install, the ability to run them is determined by the licenses you have purchased.
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulators and Design Entry</td>
<td>This is the basic ADS software, including the Design Environment, Data Display, and Analog/RF Systems and Signal Processing simulators</td>
</tr>
<tr>
<td>Vendor Component Libraries</td>
<td>Parts libraries, such as the RF Transistor Library or the Analog Parts Library</td>
</tr>
<tr>
<td>Momentum Planar EM Simulator</td>
<td>The Momentum planar electromagnetic simulator</td>
</tr>
<tr>
<td>Design Rule Checker/Art Translators</td>
<td>Design Rule Checker verifies layouts and the artwork translators include MTOOLS (Gerber, DXF), IGES, GDSII, etc.</td>
</tr>
<tr>
<td>Digital Filter Designer</td>
<td>Synthesizes a wide-range of FIR and IIR digital filters based on user requirements</td>
</tr>
<tr>
<td>DSP Synthesis</td>
<td>Implements high-level DSP designs into ASICs or FPGAs</td>
</tr>
<tr>
<td>SPICE Model Generator</td>
<td>Generates SPICE models from S-parameter data</td>
</tr>
<tr>
<td>E-Syn</td>
<td>Synthesizes lumped- and distributed- element networks for filters, matching networks, etc.</td>
</tr>
<tr>
<td>Examples</td>
<td>Complete ADS application examples</td>
</tr>
<tr>
<td>LineCalc</td>
<td>Transmission line calculator program</td>
</tr>
<tr>
<td>Library Translator</td>
<td>A tool that assists persons responsible for library management, such as CAD administrators, in translating enterprise libraries into ADS</td>
</tr>
<tr>
<td>FLEXlm licensing software</td>
<td>An option included for installations with a license server on a separate machine</td>
</tr>
<tr>
<td>Series IV &amp; MDS to ADS Translators</td>
<td>Translate designs from Series IV or MDS into ADS 2002</td>
</tr>
<tr>
<td>Online Documentation to Hard Disk</td>
<td>Online manuals, help, and search engine installed to your hard disk.ADS 2002 uses HTML-based documentation displayed using your Web browser: Netscape version 4.5 or higher is required. ADS installs the supported Netscape version</td>
</tr>
<tr>
<td>Complete set of Advanced Design System Examples</td>
<td>Complete set of ADS examples, such as microwave circuit or signal processing examples</td>
</tr>
</tbody>
</table>
If you chose to do a Typical or Complete installation, skip to step 15.

12. For Custom Installations only: Choose the specific components you want to install. Scroll as needed to find components, as there are more than 25 options (you may not have purchased some of the options). Click on a component name to see a description. Make sure to check all boxes of components you wish to install. Choose Next to continue.

13. The options that you can install are listed and described in Table 3-2, below.

**Note** If you want to install any of the options that follow, the Simulators, Schematic Capture and Layout option must be installed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulators and Design Entry</td>
<td>This is the basic ADS software, including the Design Environment, Data Display, and Analog/RF Systems and Signal Processing simulators</td>
</tr>
<tr>
<td>Vendor Component Libraries</td>
<td>Parts libraries, such as the RF Transistor Library or the Analog Parts Library</td>
</tr>
<tr>
<td>Momentum Planar EM Simulator</td>
<td>The Momentum planar electromagnetic simulator</td>
</tr>
<tr>
<td>Design Rule Checker/Art Translators</td>
<td>Design Rule Checker verifies layouts and the artwork translators include MTOOLS (Gerber, DXF), IGES, GDSII, etc.</td>
</tr>
<tr>
<td>Digital Filter Designer</td>
<td>Synthesizes a wide-range of FIR and IIR digital filters based on user requirements</td>
</tr>
<tr>
<td>DSP Synthesis</td>
<td>Implements high-level DSP designs into ASICs or FPGAs</td>
</tr>
<tr>
<td>SPICE Model Generator</td>
<td>Generates SPICE models from S-parameter data</td>
</tr>
<tr>
<td>E-Syn</td>
<td>Synthesizes lumped- and distributed- element networks for filters, matching networks, etc.</td>
</tr>
<tr>
<td>LineCalc</td>
<td>Transmission line calculator program</td>
</tr>
<tr>
<td>Library Translator</td>
<td>A tool that assists persons responsible for library management, such as CAD administrators, in translating enterprise libraries into ADS</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>FLEXlm licensing software</td>
<td>An option included for installations with a license server on a separate machine</td>
</tr>
<tr>
<td>RFIC Dynamic Link</td>
<td>EDA framework integration based on inter-process communication; Facilitates ADS simulation using IC designs from the Cadence database</td>
</tr>
<tr>
<td>Design Kit Tool Set</td>
<td>Set of tools used to support the use of ADS Design Kits, including installation, setup, and viewing Design Kits</td>
</tr>
<tr>
<td>CDMA Design Library</td>
<td>Design library of conforming behavioral models to develop CDMA communications products to TIA/EIA-95 standards</td>
</tr>
<tr>
<td>GSM Design Library</td>
<td>Design library of conforming behavioral models to develop GSM communications products</td>
</tr>
<tr>
<td>Series IV &amp; MDS to ADS Translators</td>
<td>Translate designs from Series IV or MDS into ADS 2002</td>
</tr>
<tr>
<td>EDGE Design Library</td>
<td>Design library of conforming behavioral models to develop enhanced data-rate for GSM evolution (EDGE) communications products</td>
</tr>
<tr>
<td>3GPP W-CDMA Design Library</td>
<td>Design library of conforming behavioral models to develop 3rd-generation partnership project (3GPP) W-CDMA communications products</td>
</tr>
<tr>
<td>WLAN Design Library</td>
<td>Design library of conforming behavioral models to develop products for the 5 GHz wireless LAN market</td>
</tr>
<tr>
<td>1xEV Design Library</td>
<td>Design library of models to develop the physical layer for products based on 1xEV, which is high-speed, high-capacity wireless technology</td>
</tr>
<tr>
<td>cdma2000-Compliant Design Library</td>
<td>Design library of conforming behavioral models to develop CDMA communications products to TIA/IS-2000 standards</td>
</tr>
<tr>
<td>Digital TV Design Library</td>
<td>Design library of conforming behavioral models to develop digital TV transmitters or receivers to ISDB-T or DVB-T standards</td>
</tr>
<tr>
<td>HDL Cosimulation</td>
<td>Used to cosimulate components represented in a hardware description language</td>
</tr>
</tbody>
</table>
Installation Procedures

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linearization DesignGuide</td>
<td>Tool kit to interactively explore dynamic linearization systems at the top level with templates</td>
</tr>
<tr>
<td>Oscillator DesignGuide</td>
<td>Smart library and interactive handbook for creating useful oscillator designs and interactively characterizing their components</td>
</tr>
<tr>
<td>Passive Circuit DesignGuide</td>
<td>Provides SmartComponents and automated assistants for the design of common passive microstrip structures</td>
</tr>
<tr>
<td>Phase-Locked Loop DesignGuide</td>
<td>Interactive handbook for the creation of useful PLL designs, including templates to assist in meeting performance specifications</td>
</tr>
<tr>
<td>Power Amplifier DesignGuide</td>
<td>Interactive tool kit that includes many simulation setups and data displays that are useful for power amplifier design</td>
</tr>
<tr>
<td>Bluetooth DesignGuide</td>
<td>Interactive handbook for the creation of Bluetooth communications product designs, including templates to assist in meeting performance specifications</td>
</tr>
<tr>
<td>CDMA2000 DesignGuide</td>
<td>Interactive handbook for the creation of CDMA2000 communications product designs, including templates to assist in meeting performance specifications</td>
</tr>
<tr>
<td>Mixer DesignGuide</td>
<td>Smart library and interactive handbook for creating useful mixer designs and interactively characterizing their components</td>
</tr>
<tr>
<td>RF System DesignGuide</td>
<td>Interactive tool kit that includes many simulation setups and data displays that are useful for RF system design</td>
</tr>
<tr>
<td>WLAN DesignGuide</td>
<td>Interactive handbook for the creation of WLAN designs, including templates to assist in meeting performance specifications</td>
</tr>
<tr>
<td>Filter DesignGuide</td>
<td>Interactive handbook for the creation of filters</td>
</tr>
<tr>
<td>Developer Studio DesignGuide</td>
<td>Guidelines and procedures to help developers create and use custom DesignGuides for use in ADS</td>
</tr>
</tbody>
</table>

Choose **Next** to continue.
Note You can subsequently re-run the installation program to install anything you don't choose to install at this time.

14. For Custom Installation only: An Options tab appears that allows you to make the following choices:

Table 3-3.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online Documentation</td>
<td>This option installs the online manuals, help, and search engine to the doc directory under your specified installation location. ADS 2002 uses HTML-based documentation displayed using your Web browser. Netscape version 4.5 or higher is required; ADS installs the supported Netscape version, but if you have an older, unsupported version, make sure it's not in your path ahead of the ADS installation.</td>
</tr>
<tr>
<td>Complete set of Advanced Design System Examples</td>
<td>You can choose the complete set of examples or just the application(s) you're interested in, listed below.</td>
</tr>
<tr>
<td>Behavioral Models</td>
<td>Subset of Design Examples</td>
</tr>
<tr>
<td>Communications System Examples</td>
<td>Subset of Design Examples</td>
</tr>
<tr>
<td>Digital Signal Processing Examples</td>
<td>Subset of Design Examples</td>
</tr>
<tr>
<td>Microwave Circuit Examples</td>
<td>Subset of Design Examples</td>
</tr>
<tr>
<td>Momentum Examples</td>
<td>Subset of Design Examples</td>
</tr>
<tr>
<td>RFIC Examples</td>
<td>Subset of Design Examples</td>
</tr>
<tr>
<td>RF Board Examples</td>
<td>Subset of Design Examples</td>
</tr>
<tr>
<td>Tutorial Examples</td>
<td>Examples used with the online manuals</td>
</tr>
<tr>
<td>Training Examples</td>
<td>Examples used with training classes</td>
</tr>
</tbody>
</table>

15. A Summary tab appears, listing the components you have selected to install. You have three options:

- Choose Back if you want to go back and make changes to your selections. You can select Back as many times as necessary to reach the screen where you want to make changes.
Installation Procedures

- Choose Next if you want to keep your selections as listed and proceed with the installation.
- Choose Cancel if you want to exit the Agilent EEsof Installation Manager program without installing any software.

16. After you select Next from the Summary tab, the Install tab becomes active and the installation of software begins.

**Note**  Progress indicators only update after each module is installed, so do not be alarmed if it takes several minutes for the progress indicators to indicate a change.

17. If you have selected a Complete installation or a Custom installation that includes Vendor Parts Libraries and/or the Online Documentation, you will be prompted to unmount the currently inserted disk and mount installation Disk 2 when necessary.

ADS 2002 uses HTML-based documentation displayed using your Web browser. Netscape version 4.5 or higher, or Microsoft Internet Explorer version 4.0 or higher is required. The ADS installation program installs a supported version of Netscape in the <installation> directory and sets your path to choose this installation to view the online documentation. If you want to use a different version or installation of a supported Web browser, you will have to modify your path statement.

18. The Information box that prompts you to insert another installation disk identifies the appropriate mount commands for your system. Type the appropriate mount command into a terminal window.

To unmount a CD-ROM:

```
cd /
umount /cdrom
```

**Note**  You will need to be in the root directory to unmount the CD-ROM. If you are running Solaris 7.0/8.0 and vold is active, you can type the following command to unmount the CD-ROM: `eject cdrom`

Now, mount the required CD-ROM. Refer to step 3 for mount commands.
19. Once you have mounted the requested installation disk, choose one of the following:
   • Apply  To continue with the installation
   • Cancel  To end the installation program
   • Reset  To reset the CD-ROM mount directory path

20. When the installation is complete, an Installation Complete! message appears in the Installation Messages portion of the Install tab.

21. When you are finished, choose Done to exit the Agilent EEsof Installation Manager.

22. Unmount the installation CD-ROM:

   cd /
   umount /cdrom9

   Note  You will need to be in the root directory to unmount the CD-ROM. If you are running Solaris 7.0/8.0 and vold is active, you can type the following command to unmount the CD-ROM: eject cdrom.

23. Configure the user accounts that will run Advanced Design System as follows:

   C-Shell Users:
   Add the following at the end of $HOME/.cshrc:
   setenv HPEESOF_DIR <install_directory>
   setenv AGILEESOF_LICENSE_FILE <path_to_license_file>
   set path = (. $HPEESOF_DIR/bin $path )

   Bourne or Korn Shell Users:
   Add the following at the end of $HOME/.profile:
   HPEESOF_DIR=<install_directory>
   AGILEESOF_LICENSE_FILE=<path_to_license_file>
   PATH=:$HPEESOF_DIR/bin:$PATH
   export HPEESOF_DIR AGILEESOF_LICENSE_FILE PATH
Installation Procedures

If you will run Advanced Design System from a remote computer and you want the display to appear on your local machine, you will need to set the DISPLAY environment variable:

```bash
setenv DISPLAY <my_hostname>: 0.0 (C-Shell)
DISPLAY = <my_hostname>: 0.0 (Korn Shell, Bourne Shell)
export DISPLAY
```

In the preceding examples for C, Bourne and Korn Shell:

- `<install_directory>` is the complete path to the installation directory for Advanced Design System. For example, if you installed to `/opt/apps/hpeesof`, you would replace `<install_directory>` with `/opt/apps/hpeesof`
- `<path_to_license_file>` is the complete path to the license.lic file that contains your Advanced Design System codewords. By default, Advanced Design System will look for: `$HPEESOF_DIR/licenses/license.lic`

**Note** If you are running Common Desktop Environment (CDE) or HP VUE, your user account may be using `$HOME/.dtprofile` or `$HOME/.vueprofile` respectively to set up your user account instead of `.cshrc` or `.profile`. The `.dtprofile` and `.vueprofile` files contain a line that can be uncommented to activate the use of `.cshrc` or `.profile`. Please see your system administrator or CDE or VUE documentation for details.

24. Once the user accounts are configured, the users need to log out and log in again to activate the changes. To verify that the new environment variables are set, each user should type the following command:

```bash
env
```

Check that `HPEESOF_DIR` and `AGILEESOF_LICENSE_FILE` are set and that `PATH` contains a path to the Advanced Design System bin subdirectory.

**Note** If you installed Advanced Design System as root, the ownership of directories and files will be set to user id 1313 and group id 22. This may not be desirable in your UNIX environment. To correct this situation, we recommend that you enter the following commands after installing as root:

```bash
cd $HPEESOF_DIR
```
25. If you have not already done so, obtain your FLEXlm security codewords from Agilent EEsof and create a licenselic file. Then follow the procedures to enable FLEXlm licensing with Advanced Design System codewords. Refer to Chapter 4, Setting Up Licenses on UNIX Systems.

**Note** The enabling of FLEXlm licensing is required before you can run your Advanced Design Systems applications.

### Starting Advanced Design System

Once FLEXlm is running, and your user account is configured, you can start Advanced Design System by entering:

```
hpads
```

If you are not familiar with ADS, choose Help > Topics and Index > Quick Tour for help on getting started with Advanced Design System.

To start the Library Translator (a tool that assists persons responsible for library management, such as CAD administrators, in translating enterprise libraries into ADS), enter:

```
hplt
```

**Note** ADS Version 2002 is equivalent to ADS 190, 1.9 or 2.0. This internal version number for ADS 2002 appears in a few places, such as from Help > About Advanced Design System > Version and in the licenselic file.

**Note** For installations of Advanced Design System under HP-UX 10.20, the latest version of HP-UX patches or the HP-UX Extension Software CD-ROM must be installed before you can start the program. Refer to Chapter 2, Requirements on UNIX Systems.
Installation Procedures

Installing to Multiple Disk Partitions or Directories

If you do not have a single partition large enough to hold the entire Advanced Design System installation, you can spread the installation across partitions using symbolic or soft links. The symbolic links are created before installation to redirect files to other partitions.

For example, suppose you want to install Advanced Design System with most of the software installed in `/opt/apps/hpeesof`, but you want the example projects to be installed to `/disk2` due to lack of disk space in the `/opt` partition. Before starting the Agilent EEsof Installation Manager (as described in step 5 of the preceding section “Installing to a Single Disk Partition or Directory” on page 3-1), you would do the following:

1. Create the main installation directory:
   
   ```
   cd /opt/apps
   mkdir hpeesof
   ```

2. Create the directory that will hold the example files on `/disk2`:
   
   ```
   cd /disk2
   mkdir ads_examples
   ```

3. Create a link named `examples` in the main installation directory that points to the `/disk2/ads_examples` directory:
   
   ```
   cd /opt/apps/hpeesof
   ln -s /disk2/ads_examples examples
   ```

4. Continue with step 1 of the preceding section “Installing to a Single Disk Partition or Directory” on page 3-1. When the examples are installed, the example projects will follow the `/opt/apps/hpeesof/examples` link to `/disk2/ads_examples`.

Following is a list of the larger directory (not the complete list) names for Advanced Design System, along with approximate sizes. Any of these directories can be re-directed to another disk partition as shown above for the examples directory. The sizes shown are for a complete installation.

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Approximate Size (in Megabytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ComponentLibs</td>
<td>158 MB</td>
</tr>
<tr>
<td>bin</td>
<td>157 MB</td>
</tr>
</tbody>
</table>

3-14 Installing to Multiple Disk Partitions or Directories
Using Multiple ADS Versions

Some users prefer to maintain more than one version of ADS (such as version 2001 and 2002) and be able to run them concurrently. This section describes the steps you need to do to allow this.

If you install multiple versions of ADS on your computer, you must keep the $HOME directories of the multiple installations separate from each other. This helps in structuring all the files and also prevents problems that may arise if the configuration files are shared between multiple installations.

**Note** $HOME is the directory where all your projects are.

So for example, you may want to install ADS 2001 and ADS 2002 on the same machine. Let us assume that ADS 2001 is already installed and the $HOME directory in this case is /users/jdoe/ads2001. Thus all your project files are under this directory. Now you would like to install ADS 2002. So for ADS 2002, you would choose a new $HOME directory, for example, /users/jdoe/ads2002.

Then you could set this up and run both ADS 2001 and ADS 2002 concurrently.

**Procedure**

You need to specify the variable $HOME separately for each version of ADS that you want to run. You will need to have two directories:

/users/jdoe/ads2001 (HOME for ADS 2001)
/users/jdoe/ads2002 (HOME for ADS 2002)

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Approximate Size (in Megabytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>circuit</td>
<td>33 MB</td>
</tr>
<tr>
<td>de</td>
<td>27 MB</td>
</tr>
<tr>
<td>doc</td>
<td>200-350 MB (depending on Design Libraries)</td>
</tr>
<tr>
<td>examples</td>
<td>399 MB (if all examples are installed)</td>
</tr>
<tr>
<td>DesignGuides</td>
<td>378 MB</td>
</tr>
<tr>
<td>hptolemy</td>
<td>59 MB</td>
</tr>
<tr>
<td>modelbuilder</td>
<td>13 MB</td>
</tr>
</tbody>
</table>
Installation Procedures

Then you would run different scripts to run the version of ADS you want. Below are some example scripts. Please change them to match your system.

**Script for ADS 2001**

```
#!/bin/ksh
#
# Script for starting ADS 2001 on UNIX systems.
cd /users/jdoe/ads2001
HOME=/users/jdoe/ads2001
HPEESOF_DIR=/utils/eesof/ads2001
PATH=\$HPEESOF_DIR/bin:PATH
export HOME HPEESOF_DIR PATH

hpads
```

**Script for ADS 2002**

```
#!/bin/ksh
#
# Script for starting ADS 2002 on UNIX systems.
cd /users/jdoe/ads2002
HOME=/users/jdoe/ads2002
HPEESOF_DIR=/utils/eesof/ads2002
PATH=\$HPEESOF_DIR/bin:PATH
export HOME HPEESOF_DIR PATH

hpads
```
Chapter 4: Setting Up Licenses on UNIX Systems

This chapter describes how to set up and enable Agilent EEsof security codewords on UNIX systems. Advanced Design System uses Globetrotter Software's Flexible License Manager (FLEXlm) software for all Agilent EEsof security configurations. The FLEXlm software is installed with the Advanced Design System software and resides in the $HPEESOF_DIR/licenses/bin directory.

Note  Beginning with ADS 2002, the name of the license file has changed from license.dat to license.lic. Also, the structure of the file has been changed in several ways, for example, the DAEMON line is now called the VENDOR line.

Note  For instructions on licensing needs required for special situations, refer to the section “Special Licensing Needs” on page 4-14 in this chapter. For helpful hints on solving common licensing problems, refer to the section, “Solutions to Licensing Problems on UNIX Systems” on page A-2 in Chapter A, Troubleshooting.

Installing the Codewords

Note  This procedure assumes that you have received your Advanced Design System codewords. If you have not received them, refer to the section, “Pre-Installation Guidelines” on page 1-1 in Chapter 1, Before You Install/Quick Install.

Note  ADS 2002 requires new codewords. Earlier versions allowed cross-licensing with Series IV and MDS, which ended with this release. You must install your new codewords to run ADS 2002. Contact Agilent EEsof Business Support, as explained later in this section.
The Agilent License Information Tool is available to check your environment variable settings, display your license.lic file, and show your license and server status. Refer to “Using the Agilent License Information Tool” on page 4-19.

The codeword installation procedures are summarized in the flowchart shown in Figure 4.1. Each step identified in the flowchart corresponds to a section of this chapter that you can refer to for more detailed instructions on that particular step.

**Installing the Codewords**

**Step 1:** Save the license file that was attached to the e-mail you received to a file named license.lic.

**Step 2:** Edit license.lic file to correct the SERVER line and add VENDOR line information.

**Step 3:** Place a copy of license.lic on each SERVER machine listed in license.lic.

**Step 4:** Start lmgrd on all SERVER machines and verify that licenses are available.

**Step 5:** Configure user’s environment to access licenses from license server machines.

Ready to run Advanced Design System

---

**Note** If you are using the Mentor Graphics IFF interface for Advanced Design System, you need to install Mentor codewords in a separate procedure. Obtain information from your Mentor Graphics representative.
Step 1: Save the Codeword File to a license.lic File

When you receive your codeword file from Agilent EEsof Business Support, it will be called license.lic. Make sure to retain that filename. Most codewords are distributed by e-mail.

Step 2: Edit the license.lic File

You may need to edit your license.lic file to correct the SERVER line (replace unknown with the actual server name) and add information to the VENDOR line, as described in this section.

Note Each line in the license.lic file must be a single continuous line with each field separated by a single space. You may line wrap lines using the backslash (\') character, but be very careful not to add a space after the backslash. Otherwise, you can remove the backslash and make each INCREMENT line one continuous line.

Node-Locked File Example

The codeword file must follow the format shown in the following example. This example is from a node-locked file:

```
SERVER unknown 80fb214d
VENDOR agileesof
INCREMENT ads_datadisplay agileesof 2.0 01-jan-2002 1 \ 
  VENDOR_STRING=80fb214d HOSTID=00008645603e SIGN="008C 0B3B \ 
  B6CE F5FD A202 41E9 497E A13E 8FD7 74EC B500 077B 6A8B 43D7 \ 
  6ACC 2844 FC22 ED6F B9C5 0702 BD2C"
INCREMENT ads_layout agileesof 2.0 01-jan-2002 1 \ 
  VENDOR_STRING=80fb214d HOSTID=00008645603e SIGN="03D6 7CB8 \ 
  1839 1C88 FADD 2B28 C262 BFE5 2829 F6B6 6300 85FE E3F6 2060 \ 
  127A AC3E 3500 B5DE DF02 1B13 C474"
INCREMENT ads_schematic agileesof 2.0 01-jan-2002 1 \ 
  VENDOR_STRING=80fb214d HOSTID=00008645603e SIGN="0220 C506 \ 
  FC49 2049 A306 30FC 8D30 3679 FB9F 902A A001 BD12 AF37 5D9F \ 
  C2C2 AC85 1FC7 4DE6 D4D0 DBD4 7011"
INCREMENT sim_harmonic agileesof 2.0 01-jan-2002 1 \ 
  VENDOR_STRING=80fb214d HOSTID=00008645603e SIGN="03B4 86F8 \ 
  F981 C8F5 50DB A4CA 8EDB F6C4 83BA 5D01 3102 B3E5 CC10 EABB \ 
  A03A 87F3 C441 95B5 25E5 2EFE 3C69"
INCREMENT sim_linear agileesof 2.0 01-jan-2002 1 \ 
  VENDOR_STRING=80fb214d HOSTID=00008645603e SIGN="016E 2104 \ 
```
Floating-Licence File Example

The codeword file for a floating license is the same as the previous node-locked file example, with one exception: There is no HOSTID identifier in a floating license. Below is a sample of a section of a floating-licence file:

SERVER unknown 80fb214d
VENDOR agileesof
INCREMENT ads_datadisplay agileesof 2.0 01-jan-2002 2 \
VENDOR_STRING=80fb214d SIGN="02FC 0DC8 DA50 6376 E488 F950 35AF 8DC4 2838 C461 8003 2B99 3A53 B533 DA68 2DA8 A7AF 7464 6FOE 4C8B"
INCREMENT ads_layout agileesof 2.0 01-jan-2002 2 \
VENDOR_STRING=80fb214d SIGN="006A 8EAA 8FE3 3EC6 B329 CC25 421C 41E9 084F 0F74 AF00 E13D A9AB 43D9 F831 1F19 ED3F 3156 3F7F 306D 3BE9"
INCREMENT ads_schematic agileesof 2.0 01-jan-2002 2 \
VENDOR_STRING=80fb214d SIGN="027E B964 CEE5 C2C2 FF44 7413 6556 0117 F84A 3770 B702 FB20 31C7 D2B2 79B4 8549 7990 0BAF A653 9479 5FDF"
INCREMENT sim_harmonic agileesof 2.0 01-jan-2002 2 \
VENDOR_STRING=80fb214d SIGN="03AF 98EC 7DEB B81A C193 7453 E058 7149 0170 9EBB 6703 D1A2 20CA E144 763A 8495 1711 0DD4 1C59 0DC3 DDA1"
INCREMENT sim_linear agileesof 2.0 01-jan-2002 2 \
VENDOR_STRING=80fb214d SIGN="0316 C5A9 E9B0 F397 1273 5ED1 D439 7BA7 70C1 D03D CA02 8C8C A830 4C4A 7615 CC9B 51E7 CAEC 8152 5999 98E1"

Note: In the licencelse file, ADS Version 2002 is listed with a version number of 2.0.

SERVER Line Format

The SERVER line, by default, has the following format:

```latex
SERVER hostname hostid
```

where

hostname is the network name of the machine whose hostid appears in field 3 of the SERVER line. (See Table 4-1.)
hostid is the unique machine id of the license server machine. (See Table 4-2.) Optionally, a TCP port number may be specified on this line, for example:

\[\text{SERVER hostname hostid 27000}\]

tcp_port_number is the TCP port number that the license server will listen at for license requests.

Table 4-1. Determining hostname of a machine

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP-UX</td>
<td>/usr/bin/hostname</td>
</tr>
<tr>
<td>Sun</td>
<td>/bin/hostname</td>
</tr>
<tr>
<td>IBM AIX</td>
<td>/bin/hostname</td>
</tr>
</tbody>
</table>

Table 4-2. Determining hostid of a machine

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP-UX</td>
<td>/usr/bin/uname -i</td>
</tr>
<tr>
<td>Sun</td>
<td>/bin/hostid</td>
</tr>
<tr>
<td>IBM AIX</td>
<td>/bin/uname -m</td>
</tr>
</tbody>
</table>

SERVER Line Guidelines

- Your license file should contain an odd number of SERVER lines; for example, 1 or 3. If you have 3 SERVER lines, the first SERVER is the primary license server and the other two are backup servers. All three SERVER lines must use the same tcp_port_number.
- You may only change the hostname and the optional tcp_port_number fields.
- Adding or removing SERVER lines requires a new license.lic file.
- By default, Agilent EEsof sets hostname to unknown. The SERVER line does not contain a port address. FLEXlm software assigns a port address in the range of 27000 to 27009. The examples in this manual use a port address of 27000, but your license file may differ. If you do not want to use the port address assigned by FLEXlm, specify any other unused port number for your network.
- If the hostid is wrong, or changes for some reason, you will need to request a new license.lic file from Agilent EEsof.
Here are examples of properly configured SERVER lines:

```bash
SERVER  joshua  2072EFE45  (default)
SERVER  isaiah  20472A3D3  27000  (optional)
```

**VENDOR Line Format**

The VENDOR line, by default, has the following format:

```bash
VENDOR  daemon_name
```

where

`daemon_name` is the name of the vendor daemon.

Optionally, you may specify a path to the vendor daemon and a path to the FLEXlm options file, for example:

```bash
VENDOR  agileesof  /my_install_dir/licenses/vendors/agileesof
```

where

`path_to_daemon` is the full path to the vendor daemon executable.

`path_to_option_file` is the full path to a file containing FLEXlm options for the vendor daemon. This is an optional field.

**VENDOR Line Guidelines**

- During installation of Advanced Design System, the vendor daemon is installed in the `$HPEESOF_DIR/licenses/vendors` directory.
- The `daemon_name` must be `agileesof`.
- The `path_to_option_file` is intentionally left blank. If you want to use FLEXlm options, you must add a full path to your option file. To learn about FLEXlm options, refer to the section “Using FLEXlm Options” on page 4-14. If the file does not exist and this option is not blank, a warning message will appear in the `flex.log` file.
- Here is an example of a properly configured VENDOR line (without an options file):

```bash
VENDOR  agileesof  /my_install_dir/licenses/vendors/agileesof
```
INCREMENT Line Format

The INCREMENT lines must have the following format:

```
INCREMENT feature vendord ver exp num cword pri_srvr nodeck_id
```

where

- **feature** is the name of the feature licensed by this line.
- **vendord** is the name of the vendor daemon that will manage this feature.
- **ver** is the version of the feature licensed by this line.
- **exp** is the expiration date of this license.
- **num** is the number of licenses this line enables.
- **cword** is the encrypted codeword.
- **pri_srvr** is the primary license server's hostid in double quotes and prefaced by "s=".
- **nodeck_id** is an optional field. If this field exists, it is the hostid of the machine that this license is node-locked to. Only the machine whose hostid appears in this field may checkout this license.

INCREMENT Line Guidelines

- None of the fields on the INCREMENT lines are editable. Any change made to any of the fields on an INCREMENT line will make that feature invalid. The only valid edit of an INCREMENT line is to add a backslash (\) to line wrap the line. Be careful not to add an extra space between fields when using a backslash to line wrap an INCREMENT line.

- Here are two examples of valid INCREMENT lines.

  **Floating license example:**

  ```
  INCREMENT ads_layout agileesof 2.0 01-jan-2002 2 \ 
    VENDOR_STRING=80fb214d SIGN="006A 8EAA 8FE3 3EC6 B329 CC25 \ 
    421C 41E9 084F 0F74 AF00 E13D A9AB 43D9 F831 1F19 ED3F 3156 \ 
    3F7F 306D 3BE9"
  ```

  **Node-locked license example:**

  ```
  INCREMENT ads_schematic agileesof 2.0 01-jan-2002 1 \ 
    VENDOR_STRING=80fb214d HOSTID=00008645603e SIGN="0220 C506 \ 
    ```
Setting Up Licenses on UNIX Systems

The backslash used to line wrap these two INCREMENT line examples is prefaced by a space and contains a carriage return immediately after it. The \ character is the absolute last character of the line it is on.

Step 3: Place license.lic Copy on the SERVER Machine(s)

A copy of the license.lic file must be placed on all SERVER machine(s) listed in the license.lic file.

License Placement Guidelines

- The recommended location for the license.lic file is:
  
  \$HPEESOF_DIR/licenses/license.lic

- You might need root permission to copy the license.lic file into the Advanced Design System installation directory if Advanced Design System was installed by a user logged in as root.

- You can choose to locate the license.lic file someplace else on the SERVER machine(s). If you choose to do this, make sure that Advanced Design System users properly set AGILEESOF_LICENSE_FILE as described in step 5.

- Make sure that the license.lic file has at least read permission for all users:

  cd \$HPEESOF_DIR/licenses
  chmod 555 license.lic

  This command gives you read/executable permissions only.

- All SERVER machines must have an identical copy of the license.lic file.

Step 4: Start lmgrd on the SERVER Machine(s)

Following are guidelines and a procedure to start lmgrd on the SERVER machine.

Guidelines for Starting lmgrd

- If you have more than one SERVER line in the license.lic file, you must start lmgrd on all the SERVER machines to enable the licenses.

- You only need to run lmgrd on the SERVER machine(s).
• If the SERVER machine(s) has Advanced Design System installed on it, you will find the FLEXlm license manager daemon (lmgrd) in the $HPEESOF_DIR/licenses/bin directory. If the SERVER machine does not have Advanced Design System installed, you can copy the $HPEESOF_DIR/licenses directory from the machine that has Advanced Design System installed.

• This version of Advanced Design System installs v7.2 of FLEXlm. Make sure you use the v7.2 lmgrd and agileesof supplied or a newer version of lmgrd. You can determine the version of lmgrd and agileesof by typing the following commands:

```bash
cd $HPEESOF_DIR/licenses/bin
./lmgrd -v

cd $HPEESOF_DIR/licenses/vendors
./agileesof -v
```

**Note** HP-UX users must set the permissions on /dev/lan0 to read, write and execute for all users before attempting to start lmgrd. You must have root permissions to do this:

```
chmod 777 /dev/lan0
```

To start lmgrd:

Change the directory to where lmgrd resides on the SERVER machine and execute lmgrd. For example:

```bash
cd $HPEESOF_DIR/licenses/bin
./lmgrd -c ../license.lic > ../flex.log
```

The login executing lmgrd must have write permissions to the directory specified for flex.log.

All error, warning and status messages will be redirected to the flex.log file. After starting lmgrd, wait approximately 30 seconds, then look at the contents of flex.log to see if there are any errors that need to be corrected. Some common errors and their solutions are listed in the section, “Solutions to Licensing Problems on UNIX Systems” on page A-2 in Appendix A, Troubleshooting.
Setting Up Licenses on UNIX Systems

To verify that the licenses are available:

Make sure that the flex.log file does not contain any errors, then run lmstat as follows:

```
cd $HPEESOF_DIR/licenses/bin
./lmutil lmstat -a -c ../license.lic | more
```

Or, you may launch the Agilent License Information Tool to do this. Refer to “Using the Agilent License Information Tool” on page 4-19 for more information.

If the licenses are available, you should see a listing similar to the following:

```
lmutil - Copyright (C) 1989-1994 Globetrotter Software, Inc.
Flexible License Manager status on Tue 8/26/99 07:39
License server status (License file: ./license.lic):
    joshua: license server UP (MASTER)
Vendor daemon status (on joshua):
    agileesof (v3.x): UP
Feature usage info:
Users of Circuit_convolution: (Total of 3 licenses available)
Users of Circuit_envelope: (Total of 3 licenses available)
Users of Circuit_harmonic: (Total of 3 licenses available)
Users of Circuit_linear: (Total of 3 licenses available)
Users of Circuit_nwa: (Total of 3 licenses available)
Users of Circuit_transient: (Total of 3 licenses available)
Users of Layout: (Total of 3 licenses available)
Users of Microwave_lib: (Total of 3 licenses available)
Users of Schematic: (Total of 3 licenses available)
```

Step 5: Configure the User’s Environment to Access Licenses from the SERVER Machine(s)

Before attempting to start Advanced Design System, each user must configure their login environment to allow access to the licenses on the SERVER machine(s). This is accomplished by setting an environment variable named AGILEESOF_LICENSE_FILE in the user’s .profile or .cshrc.

**Note** The existence of the AGILEESOF_LICENSE_FILE environment variable will override any AGILEESOF_LICENSE_FILE settings you may have set up. If AGILEESOF_LICENSE_FILE is not set, AGILEESOF_LICENSE_FILE will be used.
For example:

C Shell:

    setenv AGILEESOF_LICENSE_FILE $HPEESOF_DIR/licenses/license.lic

Bourne/Korn Shell:

    AGILEESOF_LICENSE_FILE=$HPEESOF_DIR/licenses/license.lic
    export AGILEESOF_LICENSE_FILE

You can avoid the need to have a copy of the license.lic file directly on the machine running Advanced Design System by setting AGILEESOF_LICENSE_FILE as follows:

    AGILEESOF_LICENSE_FILE=port@SERVER_hostname

where

    port is the TCP port number from the SERVER line(s) of the license.lic file.
    SERVER_hostname is the network name of a SERVER machine serving Advanced Design System licenses. This must be a name that the SERVER is known by on the network. You should be able to successfully ping this name from the machine that will run Advanced Design System.

Here are some examples of AGILEESOF_LICENSE_FILE set up this way:

C Shell:

    setenv AGILEESOF_LICENSE_FILE 1705@joshua

Bourne/Korn Shell:

    AGILEESOF_LICENSE_FILE=1705@joshua
    export AGILEESOF_LICENSE_FILE

If you want to access multiple license servers, the syntax for the--

Bourne/Korn shell is:

    export
    AGILEESOF_LICENSE_FILE=27000@server1:27000@server2:27000@server3

C shell is:

    setenv AGILEESOF_LICENSE_FILE
    27000@server1:27000@server2:27000@server3
Setting Up Licenses on UNIX Systems

However, in this case, “server” should be replaced by the actual license server name or IP address, and the “27000” may need to be changed to the actual port number on the license server.

Note that the list of servers is separated by colons (:).

The issue of running FLEXlm-licensed products from multiple vendors is described in the section "Merging Multiple Vendor Licenses into One File" on page 4-16.

Codewords are now installed and active and you are ready to run Advanced Design System.

Using a UNIX-to-PC Floating License

A PC system can access the UNIX license server’s license.lic file in either of two ways:

- By copying the license.lic file from the UNIX license server to the PC’s $HPEESOF_DIR\licenses folder
- By setting the AGILEESOF_LICENSE_FILE variable on the PC to point to the UNIX license server as follows:
  
  set AGILEESOF_LICENSE_FILE=<port>@<host>

  For example:
  
  set AGILEESOF_LICENSE_FILE=27000@joshua

  where

  27000 is the port number on the SERVER line in the license.lic file on the UNIX license server
  
  joshua is the hostname of the UNIX license server

  Conversely, the license server can be a PC with a floating license on a LAN card or dongle key and the UNIX computer can be set to point to it in the same way by using its host name or IP address.

  This can be done in the autoexec.bat file for Windows 98 and in the System Environment variables for Windows NT/2000.
Automating FLEXlm License Manager Startup

You can automate the FLEXlm startup so that lmgrd is started automatically each time the license server machine is rebooted by adding the following three lines for a startup routine to the appropriate rc file for your operating system:

```
/ads/licenses/bin/lmgrd -c /ads/licenses/license.lic >
/ads/licenses/flex.log &
echo "Starting Agilent EEsof FLEXlm license daemon......"
/usr/bin/sleep 5
```

**Note**  Be sure to change all references to `/ads` to the actual path of your Agilent EEsof software installation directory.

Following are separate instructions for the supported operating systems.

**HP UX Operating System**

2. Create a file in this directory named `Sagileesof`.
3. Place the FLEXlm startup routine (shown above) into this file.
4. Set the permissions for this file as follows:
   ```
   chmod 755 Sagileesof
   chown root Sagileesof
   chgrp sys Sagileesof
   ```

**Sun Operating Systems**

1. Change to the `/etc/rc3.d` directory.
2. Create a file in this directory called `Sagileesof`.

**Note**  The S is capitalized. All other letters are in lower-case.
Setting Up Licenses on UNIX Systems

3. Place the FLEXlm startup routine (shown above) into this file.
4. Set the permissions for this file as follows:
   
   chmod 755 Sagileesof  
   chown root Sagileesof  
   chgrp sys Sagileesof

Special Licensing Needs

Following is additional information that will be useful for certain special licensing requirements that you may have.

For additional updated information on FLEXlm, refer to the following Globetrotter software website:

   http://www.globetrotter.com

Using FLEXlm Options

An options file allows the license administrator to control various operating parameters of FLEXlm. Specifically the license administrator can:

- Allow the use of features based on user, hostname or display name.
- Deny the user of features based on user, hostname or display name.
- Reserve licenses based on user, hostname or display name.
- Control the amount of information logged about license usage.

Options files allow the license administrator to be as secure or open with licenses as desired.

Creating an Options File

To create an options file:

1. Use the appropriate options listed in the next section to create the options file using any text editor. You can put the options file anywhere. However, Agilent EEsof recommends locating the options file in the same directory as your license.lic file:

   $HPEESOF_DIR/licenses/agileesof.opt
2. Add the pathname to the options file in the license.lic file as the fourth field on the VENDOR line for agileesof. For example:

```
VENDOR agileesof /my_install_dir/licenses/vendors/agileesof
    /my_install_dir/licenses/agileesof.opt
```

### Available Options

The available options are:

- **EXCLUDE** Deny a user access to a feature.
- **EXCLUDEALL** Deny a user access to all features served by this vendor daemon.
- **GROUP** Define a group of users for use with any options.
- **INCLUDE** Allow a user to use a feature.
- **INCLUDEALL** Allow a user to use all features served by this vendor daemon.
- **NOLOG** Turn off logging certain items.
- **REPORTLOG** Specify that a logfile be written suitable for use by the FLEXadmin End-User Administration Tool.
- **RESERVE** Reserve licenses for a user or groups of users.
- **TIMEOUT** Works only for user-specified simulator and library licenses.
- **TIMEOUTALL** Works for all simulator and library licenses.

You can include comments in your options file by starting each comment with a pound sign '#'. Everything in the options file is case-sensitive. Be sure that user names and feature names, for example, are entered correctly.

Refer to “The FLEXlm Options File” on page B-1, for more detailed information on the Options file.

### Updating the license.lic File

If you have been running FLEXlm and receive updated codewords from Agilent EEsof, you can add the new licenses to the FLEXlm environment as follows:

1. Replace your existing licenselic files on the license servers, and any other machine that has a license.lic file with the new codewords.
Setting Up Licenses on UNIX Systems

2. On the primary server, run `lmutil lmreread`. This causes the `lmgrd` on the primary server to re-read the license file and update all of the other `lmgrd` processes on the network. The primary server is the first SERVER line in the license file, with the new codewords.

3. After you have done this, you can run `lmutil lmstat -a` to verify that the license servers have received the new license information.

If this does not work, you may need to stop all of the `lmgrd` processes on your network and then restart them as described in the section “Installing the Codewords” on page 4-1.

Merging Multiple Vendor Licenses into One File

When you are running FLEXlm-licensed products from multiple vendors, you may need to take steps to prevent licensing conflicts during installation. There are three ways you can accomplish this:

• Multiple license server nodes; each running one `lmgrd` and one license file
• One license server node running one `lmgrd` and one license file
• One license server node running multiple `lmgrds` and multiple license files

Note that each `lmgrd` can only read a single license file. In the first option mentioned, you will have more license servers to monitor. In the third option, you have only one server but multiple `lmgrds` to administer.

Your product’s license file(s) define the license server(s) by hostname and hostid in the SERVER line(s) in the license file. If the license files for two or more products contain identical hostids on the SERVER line(s), then these files can be combined. If the license files for two products contain different hostids on a SERVER line, then the license servers for those products will be running on different nodes and the license files cannot be combined.

If you have two or more products whose license servers run on the same node (as specified by the SERVER lines in the license files), you may be able to combine the license files into a single license file. If the SERVER lines in those files have identical hostids, then you can combine the files into a single file. If the SERVER lines have different hostids, then you must keep the license files separate.

More precisely, you can combine two license files under the following conditions:

• The number of SERVER lines in each file is the same.
• The hostid field of each SERVER line in one file exactly matches the hostid field of each SERVER line in the other file.

Some possible reasons license files may not be compatible are:

• License files are set up to run on different server nodes, so hostids are different.
• One file is set up for single server (has only one SERVER line), the other is set up for redundant servers (has multiple SERVER lines).
• One vendor uses a custom hostid algorithm, so the hostids on the SERVER lines are different even though the files are for the same machine.

If your license files are compatible as described above, then you have the option of combining license files and running a single lmgrd, as described in the following section, “Combining License Files from Multiple Vendors” on page 4-17. If the license files are not compatible, then you must keep the license files separate and run separate copies of lmgrd for each license file, as described in the section, “Using Separate License Files on the Same Server Node” on page 4-18.

Note that you are not required to combine compatible license files. You always have the option of running separate lmgrds, and there is virtually no performance or system-load penalty for running separate lmgrd processes.

Combining License Files from Multiple Vendors

If your license files are compatible, you can combine them with any text editor. To combine license files, read all of the compatible license files into one file, then edit out the extra SERVER lines so that only one set of SERVER lines remains. Write out this data, and you have your combined license file.

If you combine license files from multiple vendors, it is a good idea to keep a copy of the combined license file in each vendor’s default license file location. This way, your users can avoid having to set AGILEESOF_LICENSE_FILE, because each package finds its license information in the default place. On UNIX, you can do this with a symbolic link from each default location to the location of the combined license file.

FLEXlm Version Component Compatibility

When you combine license files for two different FLEXlm-licensed products, it may be the case that those products do not use the same version of FLEXlm. FLEXlm is designed to handle this situation. There are two basic compatibility rules for FLEXlm:
Setting Up Licenses on UNIX Systems

• A newer lmgrd can be used with an older vendor daemon, but a newer vendor daemon might not work properly with an older lmgrd.

• A newer vendor daemon (or lmgrd) can be used with an older client program, but a newer client program might not work properly with an older vendor daemon.

From these two compatibility rules come the simple rules for selecting which version of administration tools to use:

• Always use the newest version of lmgrd and the newest version of each vendor daemon.

• Use the newest FLEXlm utilities.

For specific application programs, you can use either the new or the old version (with the assumption that the vendor daemon that for that application is at least as new as the application).

Using Separate License Files on the Same Server Node

You must run a separate copy of lmgrd for each license file. When you run multiple copies of lmgrd, there are two details to remember:

• The port number on the SERVER line of each license file must be unique. You can use a standard text editor to change the port number in each license file so that they are all different.

• You must make sure that you are using a compatible version of lmgrd when you start it up for a particular license file. This can be done by using an explicit path to lmgrd.

When running client programs (such as a licensed application), you can set the AGILEESOF_LICENSE_FILE environment variable to point to multiple license files. For example, you may have a license file from vendor ABC and a license file from vendor XYZ with incompatible servers. You can place the license file from vendor ABC into:

/usr/flexlm/abc.dat

and the license file from vendor XYZ into:

/ usr/ flexlm/ xyz.dat
then set the AGILEESOF_LICENSE_FILE environment variable to point to both of them. Each name in AGILEESOF_LICENSE_FILE should be separated by a colon (`:`) on UNIX systems.

In the C shell:

```
% setenv AGILEESOF_LICENSE_FILE /usr/flexlm/abc.dat:/usr/flexlm/xyz.dat
```

In the Korn and Bourne shells:

```
# AGILEESOF_LICENSE_FILE=/usr/flexlm/abc.dat:/usr/flexlm/xyz.dat
# export AGILEESOF_LICENSE_FILE
```

AGILEESOF_LICENSE_FILE can point to only one license file for FLEXlm v1.x applications.

---

**Note** For helpful hints on solving common licensing problems, refer to the section, “Solutions to Licensing Problems on UNIX Systems” on page -2 in Appendix A, Troubleshooting.

---

**Setting Up Redundant (Backup) License Servers**

Some sites choose to set up redundant or backup license servers, in case a primary server is unavailable. If your license.lic file has an odd number of SERVER lines, that is, 3, 5, 7, etc., you have a redundant license server configuration. The license setup is identical to a single SERVER configuration, with the exception that no licenses will be available until a majority of the license servers are running.

For example, if you have 3 SERVER lines, at least 2 must be up and running before any licenses will be available for checkout. If you have 5 SERVER lines, at least 3 must be up and running.

If you have redundant license servers, make sure that the FLEXlm software is loaded on each of them. You also must start the FLEXlm software (lmgrd) on each server. The licenses will not be available for checkout until a majority of the license servers are running.

**Using the Agilent License Information Tool**

The Agilent License Information Tool is available to check your environment variable settings, display your license.lic file, and show your license and server status. To
Setting Up Licenses on UNIX Systems

access this tool, from the ADS Main or Schematic window, choose Help > License Information. If you are unable to run ADS, you may be having a problem with licenses. In this case, run the tool from the terminal window, as follows:

Type <installation directory>/ bin/ aglmtool and press Enter.

The following dialog box appears:

For more information on the Agilent License Information Tool, refer to Chapter 1, Program Basics, in the User's Guide.
Chapter 5: Setting Up Printing and Plotting on UNIX Systems

This chapter describes setting up printing and plotting from Advanced Design System on UNIX systems.

Note  Advanced Design System uses Xprinter for all Postscript, HPGL2 and PCL printing. For a complete list of output devices supported with Xprinter, consult the HTML file called Supported_Printers_XPV331.html, which is located in the Advanced Design System installation directory path as follows:

<installation directory>/xprinter

This file lists the supported printers and also has a link to the Bristol website for the latest printer drivers. However, as new printer models and drivers are always evolving, the responsibility to provide good Xprinter drivers principally lies with the manufacturer of your printer.

Printing From UNIX

Printing and plotting from Advanced Design System is accomplished by establishing the desired print setup and then choosing File > Print. For a complete description of Advanced Design System printing, refer to Chapter 11, Printing and Plotting in the Advanced Design System User’s Guide.

Note  The ADS printing information contained in this chapter assumes that you have already set up your UNIX system for printing.
Adding a Printer

Note: Make sure that your $HOME/.XprinterDefaults file has read and write permissions for your login account.

If not, type chmod 777 $HOME/.XprinterDefaults.

The basic steps required for adding a printer through the Print Setup dialog box are:

1. Choose File > Print Setup and a dialog box appears.
2. Click **Install** and a dialog box appears listing all currently installed printers.
3. Click **Add Printer** and a dialog box appears listing all available printer devices and all currently defined ports.

![Add Printer dialog box](image)

If the printer you want to use doesn’t have a driver listed, you can try the following:

- Use the closest match in the list based on the class/type of printer.

- Download a driver from the manufacturer’s website. If the website doesn’t have a UNIX driver listed, try the PC (Windows) driver. After you download the .ppd file, save it to the $HPEESOF_DIR/xprinter/ppd directory as a .ps (PostScript) file, that is, with a .ps extension.
4. Click **Define New Port** and a dialog box appears listing all currently defined ports.

5. Add all ports you want to access for printing:
   - On HP 700 and Sun Solaris workstations, click **Spooler** and the list of ports is automatically generated (based on your printcap file).
   - On all other workstations, type the port definition in the Edit Port field using the following syntax: printer name=print command, where print command is the print alias, just as you would type it in the terminal window. Click **Add-Replace**. Repeat for each desired port.

<table>
<thead>
<tr>
<th>Ports</th>
<th>Delete Highlighted Port from List</th>
<th>HP 700 and Sun Solaris Only—Automatically List All Defined Ports</th>
<th>Close Dialog Box Accepting Changes</th>
<th>Close Dialog Box Without Accepting Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>local-tp -$SPDDOCNAME</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ipaux-tp -d ipaux</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ps-tp -d ps</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note**  Port names can be any names you choose with the exception of `FILE`: which is a reserved port name.
6. Click **Dismiss** to accept the new port definitions and return to the Add Printer dialog box. The Current Port Definitions list box is updated.

7. Select the desired printer from the list of Printer Devices.

8. Select the port you want to associate with this printer.

9. Click **Add Selected**. The Printer Installation dialog box is updated.

If you defined multiple ports, you can associate a printer with each, as just described.

10. **Dismiss** the Add Printer and Printer Installation dialog boxes. You will now be able to select any of the installed printers, as needed.
Appendix A: Troubleshooting

Following are some useful tips for resolving problems that might occur after you have installed Advanced Design System.

ADS Will Not Start

It is possible to install programs or options for which you have not purchased licenses. Although the icons and features will appear in the software, you cannot access the applications without a license. Contact your Agilent EEsof sales representative to obtain additional licenses.

If your Advanced Design System applications will not start:

• Make sure all of your licensing requirements are correctly set up, as explained in “Setting Up Licenses on UNIX Systems” on page 4-1.

• Using a text editor open and review the install.log file in your installation directory to see if there are any apparent problems with the installation structure. (You can re-run Setup if necessary to re-install.)

• Try using the Agilent License Information Tool, which is available to check your environment variable settings, display your license.lic file, and show your license and server status. Refer to “Using the Agilent License Information Tool” on page 4-19 for more information.

If you cannot find the problem, run ADS in verbose (debug) mode and contact Technical Support to help pinpoint the problem. Please see the next section.

Starting ADS in Verbose Mode (Debug Mode)

ADS 2002 can be started in verbose (debug) mode to display more information about what is occurring as ADS runs. This extra information can be very useful to debug a problem with ADS both at startup and in general operation. In verbose mode, ADS writes log files that contain this information.

These log files can be sent by e-mail to Agilent EEsof EDA Technical Support for assistance.

To start ADS in verbose mode, do the following:

1. Open a UNIX terminal window.
Troubleshooting

2. Type `hpadsVerbose`.
This will start ADS. You will see some messages indicating the location of two log files. Note the location of these files as indicated in the messages. The filenames are as follows:
   
   - ads_daemon.log
   - ads_verbose.log

**Note** If `hpadsVerbose` is not found, you may need to set the HPEESOF_DIR and PATH environment variables as described in “Before You Install/Quick Install” on page 1-1.

Run ADS until the problem you are trying to debug occurs, then take a look at the ads_daemon.log and ads_verbose.log files for errors.

If you can't locate the trouble based on the contents of the log files, please contact Agilent EEsof EDA Technical Support. You will want to e-mail the log files to the support engineer you work with.

**Solutions to Licensing Problems on UNIX Systems**

Following are solutions to common problems that occur regarding the FLEXlm licensing setup for Advanced Design System.

For additional updated information on FLEXlm, refer to the following Globetrotter Software website:
   
   http://www.globetrotter.com

**Where to Begin**

If you are having trouble getting FLEXlm working, the best place to begin troubleshooting is the flex.log file. The flex.log file is typically located in $HPEESOF_DIR/licenses.

Read the flex.log file and look for error or warning messages.

If nothing shows up in the flex.log file, try setting the following environment variable, then start Advanced Design System:
C Shell (/bin/csh)

    setenv HPEESOF_DEBUG_MODE all

Bourne/Korn Shell (/bin/sh, /bin/ksh)

    HPEESOF_DEBUGMODE=all
    export HPEESOF_DEBUGMODE

Look for errors or warnings in the shell where you started Advanced Design System.

Common Errors and Solutions

Following are possible solutions to certain license-related error messages that occur.

Error:
Inconsistent encryption code

Solution:
This error occurs when the information on the INCREMENT lines in the license.lic file is corrupted. Check the license.lic file for the following:

1. Make sure that each line of the license.lic file is a single continuous line with each field separated by a single space.

2. If there are backslash characters ('\') line wrapping the lines, make sure that the backslash character is the absolute last character on its line. Even a space after the \ will cause a problem.

3. Try removing the backslash characters and joining the INCREMENT lines, so that each INCREMENT line is a single continuous line with no line wrap.

4. If the license.lic file was transferred from DOS to UNIX, make sure to remove the control M's (^M) at the end of all the lines in the license.lic file. If spaces are added to the end of each line to eliminate the ^M's, the spaces must also be removed. The spaces turn out to be just as disruptive as the ^M's. The best way to remove the ^M's is using the vi editor and the following substitution command:

    :1,$ s/.$//g

5. Make sure that none of the original SERVER line hostid information has been changed. Make sure that none of the SERVER lines have been eliminated.

Error:
Troubleshooting

Invalid host or Unable to determine machine id

Solution:
This can be caused by one of the following:

1. Make sure that the information on the SERVER line(s) in licenselic is correct.

2. If the licenses are node-locked, and you attempt to run Advanced Design System on a machine other than the machine the licenses are node-locked to, you will get a license error indicating invalid host. To check if this is the case, look at the $HPEESOF_DIR/licenses/licenselic file and check the INCREMENT lines. If each INCREMENT line ends in a machine hostid, then the licenses are node-locked to the machine whose id is shown. You can, however, export the display from the node-locked machine to another display.

3. If you are on an HP workstation, check the permissions of the /dev/lan0 file. This file must have read and write permissions for all:

   chmod 777 /dev/lan0

   The FLEXlm Imgrd and agileeosf vendor daemons use this file and must be able to read and write to this device.

Error:
Invalid system clock time

Solution:
FLEXlm detects when systems have had their dates set more than 24 hours back, and prevents users from using expired licenses by setting the clock back. It works by looking for any files in "/" or "/etc" that have a date more than 24 hours in the future.

Use the command ls -lat in "/" and "/etc" to find the offending file(s). The date of the offending file(s) can be corrected by using the touch command:

   touch <filename>

If the file is a link, the link must be removed and then recreated. If the link itself is dated ok, check the date of the actual file or directory it points to. The pointed to file must also have a valid date.

Error:
Feature <feature name> is not enabled yet

Solution:
FLEXlm codewords have enable dates as well as expiration dates. If the codeword enable date is in the future with respect to the current machine date, then this error will occur.

First check the date on the computer. If it is not today’s date, correct it. On UNIX systems, the date can be set using the date command:

```
date mmddhhmm[yy]
```

For example, to set the date to 12 Sept, 2001 at 13:30, the command would be:

```
date 0912133001
```

If this still does not correct the problem, or if the date is correct, then request new codewords with an enable date set to today’s date.

**Error:**

Cannot connect to license server

The flex.log file contains the following errors:

```
(lmgrd) Started agileesof
(agileesof) Vendor daemon can't talk to lmgrd (cannot connect to license server) port 1700
(lmgrd) Vendor daemon died with status 241
(lmgrd) Since this is an unknown status, lmgrd will attempt to re-start the vendor daemon.
(lmgrd) REStarted agileesof (internet tcp_port xxxx)
```

**Solution:**

Make sure that the lmgrd and agileesof daemon are the correct version (version 6.1 or higher). The lmgrd daemon should have the same or higher version number as agileesof. You can check version numbers as follows:

```
cd $HPEESOF_DIR/licenses
./bin/lmgrd -v
./vendors/agileesof -v
```

Make sure that the workstation is connected to a network or that the network connector on the workstation is properly terminated. FLEXlm will not work if the network connection is down or if the network services are not starting properly. Check all physical network connections to make sure that they are okay and look for
Troubleshooting

errors during machine boot up. On HP 700 workstations, look at the /etc/rc.log file for errors.

Make sure that the agileesof is being started successfully by lmgrd. If agileesof cannot be started from the path specified on the VENDOR line in the license.lic file, this error will occur. Also make sure that the agileesof file has execute permissions:

```bash
    cd $HPEESOF_DIR/licenses/vendors
    chmod 755 agileesof
```

Error:
Retrying socket bind (address already in use)

Solution:
The tcp port number specified on the SERVER line in the license.lic file is in use by another process. Try the following: Kill any stranded lmgrd processes. Remove the /usr/tmp/.flexlm/lmgrd.xxxx file that contains the tcp port you want to use. You can remove the entire /usr/tmp/.flexlm directory if you are the only one using lmgrd on this machine, then restart lmgrd. If you still have a problem, try using a different tcp port number on the SERVER line in license.lic and then restart lmgrd.

Here is an example of properly configured SERVER lines:

```text
    SERVER joshua 2072EFE45 1705
    SERVER isaiah 20472A3D3 1705
    SERVER jonah 2052C6416 1705
```
Agilent EEsof Technical Support

Agilent EEsof worldwide technical support is available Monday through Friday. The toll-free North America hotline is open 6:00 am to 5:00 pm PT. Throughout Europe, the localized Online Technical Support Centers are open 8:30 am to 5:30 pm, local time; throughout Asia, the localized Customer Response Centers are open 9:00 am to 6:00 pm, local time.

The e-mail addresses for the various regions are listed below. However, for both the regional e-mail addresses and local telephone numbers for more than 25 countries, please refer to the Agilent EEsof Web site at

http://www.agilent.com/eesof-eda

Then choose Technical Support > Select Technical Support Pages > Contact Technical Support

North America
Phone: 1 800 47 EEsof (473-3763)
6:00 am to 5:00 pm Pacific Time · Fax: 818-879-6465
e-mail: eesof_support@agilent.com

Europe
e-mail: eesof-europe_support@agilent.com

Japan
e-mail: edasupport@jp.agilent.com

Korea
e-mail: eesof_korea@agilent.com

Asia
e-mail: eesof-asia_support@agilent.com
Appendix B: The FLEXlm Options File

This appendix provides an overview of the syntax of a complete options file and some samples intended to illustrate ways to effectively control access to your licenses.

For more detailed information on FLEXlm, refer to the following Globetrotter Software website:

http://www.globetrotter.com

Option Syntax

**EXCLUDE**

`EXCLUDE  featurename  type  name`

Excludes a user, host, display, or group from the list of who is allowed to use the feature. Excluded users will not be allowed to use the feature.

- featurename (name of the feature being affected)
- type (one of USER, HOST, DISPLAY, or GROUP)
- name (name of the user or group to exclude)

To exclude the user hank from the list of users able to use feature f1:

`EXCLUDE f1 USER hank`

**EXCLUDEALL**

`EXCLUDEALL  type  name`

Excludes a user, host, display, or group from the list of who is allowed to use all features served by this vendor daemon.

- type (one of USER, HOST, DISPLAY, or GROUP)
- name (name of the user or group to exclude)

To exclude any user on the server chaos from using all features served by this vendor daemon:

`EXCLUDEALL HOST chaos`
GROUP

GROUP groupname usernamelist
Defines a group of users for use in INCLUDE, INCLUDEALL, EXCLUDE, EXCLUDEALL, and RESERVE option lines.
- groupname (name of the group being defined)
- usernamelist (list of user names in that group)

To define the group Hackers consisting of bob, howard, and james:
    GROUP Hackers bob howard james

HOST_GROUP

HOST_GROUP groupname hostnamelist
Defines a group of hosts for use in INCLUDE, INCLUDEALL, EXCLUDE, EXCLUDEALL, and RESERVE option lines.
- groupname (name of the group being defined)
- hostnamelist (list of host names in that group)

To define the group accounting consisting of node_a, node_b, and node_c:
    HOST_GROUP accounting node_a node_b node_c

INCLUDE

INCLUDE featurename type name
Includes a user, host, display, or group in the list of who is allowed to use the feature. Anyone not in an INCLUDE statement will not be allowed to use that feature.
- featurename (name of the feature being affected)
- type (one of USER, HOST, DISPLAY, GROUP, or HOST_GROUP)
- name (name of the user or group to include)

To include user bob in the list of users able to use feature f1:
    INCLUDE f1 USER bob
INCLUDE is required for USER_BASED features. The system administrator specifies which users are allowed to use the product, via INCLUDE, and the license limits the number of users that can be INCLUDEd.

**INCLUDEALL**

INCLUDEALL type name

Includes a user, host, display, or group in the list of who is allowed to use all features served by this vendor daemon. Anyone not in an INCLUDEALL statement will not be allowed to use these features.

- type (one of USER, HOST, DISPLAY, GROUP, or HOST_GROUP)
- name (name of the user or group to include)

To allow the user 'jane' to use all features served by this vendor daemon:

```
INCLUDEALL USER jane
```

**NOLOG**

NOLOG what

Turns off logging of specific events by the FLEXlm daemons.

- what (what to turn off; one of IN, OUT, DENIED, or QUEUED)

To turn off logging of checkins:

```
NOLOG IN
```

To turn off logging of checkouts and queued requests two separate NOLOG lines are required:

```
NOLOG DENIED
NOLOG QUEUED
```

License administrators might use this option to reduce the size of the flex.log or debug log file.

**REPORTLOG**

REPORTLOG filename
The FLEXlm Options File

REPORTLOG specifies the file which will contain the report-writer log for this vendor daemon. If filename begins with a ‘+’ character, the file will be opened for append, otherwise the file will be overwritten each time the daemon is started. FLEXadmin, a separate product available from Globetrotter, can be used to read and report on REPORTLOG files.

This file is only useful with the FLEXadmin license administration utility.

**RESERVE**

RESERVE numlic featurename type name

Reserves licenses for a specific user.

- numlic (number of licenses to reserve)
- featurename (name of feature to reserve)
- type (one of USER, HOST, DISPLAY, GROUP, or HOST_GROUP)
- name (name of the user or group to reserve licenses for)

To reserve one license of feature f1 for user mel:

```
RESERVE 1 f1 USER mel
```

Any licenses reserved for a user are dedicated to that user. Even when that user is not actively using the license it will be unavailable to other users.

**TIMEOUT and TIMEOUTALL**

TIMEOUT which works only for specified simulator and library licenses, and TIMEOUTALL, which works for all simulator and library licenses, are now supported in ADS.

**How the Vendor Daemon Uses the Options File**

When the vendor daemon is started by lmgrd, it is passed the location of the options file. The location is specified in the license file for that product, on the DAEMON line. If no file is listed the daemon will not use any options file.

There can only be one options file per vendor daemon and each vendor needs a separate options file.
Rules of Precedence in Options Files

Before you can use options to utilize licenses effectively you must understand the options file precedence. INCLUDE and EXCLUDE statements can be combined in the same options file and control access to the same features. When doing so, keep in mind the following:

• If there is only an EXCLUDE list, everyone who is not on the list will be allowed to use the feature.
• If there is only an INCLUDE list, only those users on the list will be allowed to use the feature.
• If neither list exists, then everyone is allowed to use the feature.
• The EXCLUDE list is checked before the INCLUDE list; so someone who is on both lists will not be allowed to use the feature.

Once you create an INCLUDE or EXCLUDE list everyone else is implicitly outside the group. This feature allows you, as an administrator, the ability to control licenses without having to explicitly list each user that you wish to allow or deny access to. In other words there are two approaches; you can either:

• Give most users access and list only the exceptions
  or
• Severely limit access and list only the those users that have access privileges.

Simple Options File Example

Following is a sample options file.

RESERVE 1 compile USER robert
RESERVE 3 compile HOST mainline
EXCLUDE compile USER lori

NOLOG QUEUED

This options file would:

• Reserve one license for the feature “compile” for the user “robert.”
• Reserve three licenses for the feature “compile” for anyone on a computer with the hostname mainline.
The FLEXlm Options File

- Prevent the user "lori" from using the 'compile' feature on any node on the network.
- Cause QUEUED messages to be omitted from the debug log file.

The sum total of the licenses reserved must be less than or equal to the number of licenses specified in the FEATURE line. In the example above, there must be a minimum of four licenses on the "compile" FEATURE line. If fewer licenses are available, only the first set of reservations (up to the license limit) is used.

If this data were in file /usr/local/flexlm/options/local.options, you would modify the license file DAEMON line as follows:

```
DAEMON xyzd /usr/local/xyzd /usr/local/flexlm/options/local.options
```

Limiting Access for Multiple Users

Each INCLUDE, INCLUDEALL, EXCLUDE, EXCLUDEALL, and RESERVE line must have a single user name (or group) listed. To affect more than one user name create a GROUP. For example to exclude bob, howard, and james from using the feature called "toothbrush" we could create the following options file:

```
EXCLUDE toothbrush USER bob
EXCLUDE toothbrush USER howard
EXCLUDE toothbrush USER james
```

There is an easier way though. Create a GROUP and exclude the list of users from using the feature. Like the previous example, the following options file would exclude bob, howard and james from using the feature called toothbrush:

```
# First define the group "Hackers"
GROUP Hackers bob howard james

# Then exclude the group
EXCLUDE toothbrush GROUP Hackers
```

Now when you want to allow or deny access to any feature to that group, you have an alias list to make it simple.

The GROUP function works for a list of user names prior to FLEXlm v4.0. To control access to multiple displays (and hosts in pre-v4.0 FLEXlm) you must use multiple option lines in your options file. For example, in pre-v4.0 FLEXlm to exclude all users logged in on the hosts fred and barney from using a feature called f1, add these lines to your options file:

```
```
EXCLUDE f1 USER fred
EXCLUDE f1 USER barney

In FLEXlm v4.0, you can use HOST_GROUP to allow, deny or reserve licenses for multiple hosts. For example, to exclude all users logged in on the hosts fred and barney from using a feature called f1 add these lines to your options file:

HOST_GROUP writers fred barney
EXCLUDE f1 HOST_GROUP writers

**EXCLUDE Example**

Following is an example using the EXCLUDE option.

```plaintext
# First Define the group “painters”
GROUP painters picasso mondrian klee
EXCLUDE spell GROUP painters
EXCLUDE spell USER bob
EXCLUDE spell HOST bigbrush
```

This options file would:

- Prevent the users picasso, mondrian, and klee from using the feature spell on any machine on the network.
- Prevent the user bob from using the feature spell on any machine on the network.
- Prevent any user logged into the host bigbrush from using the feature spell
- Allow any other user, as long as they are not on bigbrush, and they are not in painters and they are not bob to use the feature spell (By implication.)

Note that bob could have been added to the group painters. However, painters might be used for some other purpose in the future so the license administrator chose to handle bob as a special case here. In this case, the two EXCLUDE statements concatenate to create a list of four users.

**INCLUDE Example**

Following is an example using the EXCLUDE option.
The FLEXlm Options File

```
INCLUDE paint USER picasso
INCLUDE paint USER mondrain
INCLUDE paint HOST bigbrush
```

This options file would:

- Allow the user picasso to use the feature paint on any machine on the network.
- Allow the user mondrain to use the feature paint on any machine on the network.
- Allow any user, as long as they are on the host bigbrush, to use feature paint
- Deny access to the feature paint to anyone except picasso, mondrain or anyone from the host bigbrush (By implication.)
Appendix C: Background Information on FLEXlm

This appendix provides some general introductory information on the FLEXlm software, provided by Globetrotter Software. For more detailed information on FLEXlm, refer to the following Globetrotter Software website:

http://www.globetrotter.com

This section explains the basics of floating (network) licensing, and gives a quick overview of the components of FLEXlm. It explains where license administrators have control and where Advanced Design System users have control.

Introduction to FLEXlm

FLEXlm is best known for its ability to allow software licenses to be available (or float) anywhere on a network, instead of being tied to specific machines. Floating licensing benefits both users and license administrators. Users can make more efficient use of fewer licenses by sharing them on the network. License administrators can control who uses the licensed application, and the node(s) where the licenses will be available.

FLEXlm Components

The four main components of FLEXlm are:

- License manager daemon
- Vendor daemon
- License file
- Application program

The License Manager Daemon (lmgrd)

The license manager daemon (lmgrd) handles the initial contact with the client application programs, passing the connection on to the appropriate vendor daemon. It also starts and restarts the vendor daemons. FLEXlm permits multiple redundant license manager daemons on three server nodes, allowing you to make your license...
available if any two out of the three server nodes is running. Redundancy can be achieved with 3-server redundant servers, or by using a license file list with any number of servers.

The Vendor Daemon

In FLEXlm, licenses are granted by running processes (unless they're node-locked (uncounted), in which case they need only read the license file to run). There is one process for each vendor who has a FLEXlm-licensed product on the network. This process is called the vendor daemon. The vendor daemon keeps track of how many licenses are checked out, and who has them. If the vendor daemon terminates for any reason, all users lose their licenses (though this does not mean the applications suddenly stop running). Users normally regain their license automatically when lmgrd restarts the vendor daemon, though they may exit if the vendor daemon remains unavailable.

Client programs communicate with the vendor daemon, usually through TCP/IP network communications. The client application and the daemon processes (the license server) can run on separate nodes on your network, across any size wide-area network. Also, the format of the traffic between the client and the vendor daemon is machine-independent, allowing for heterogeneous networks. This means the license server and the computer running an application can be either different hardware platforms or even different operating systems (Windows and UNIX, for example).

The License File

Licensing data is stored in a text file called the license file. The license file is created by the software vendor, and edited and installed by the license administrator. It contains information about the server nodes and vendor daemons, and at least one line of data (called FEATURE or INCREMENT lines) for each licensed product. Each FEATURE line contains a license key based on the data in that line, the hostids specified in the SERVER lines, and other vendor-specific data.

In some environments, the licensing information for several vendors may be combined into a single license file. The default location for UNIX systems is:

/usr/local/flexlm/licenses/license.lic

You can usually override this location by setting the environment variable AGILEESOF_LICENSE_FILE to point elsewhere, or by following instructions supplied with the licensed application. If your site has software from multiple
vendors with incompatible license files (due to different sets of servers), you can keep the data in separate files and set the AGILEESOF_LICENSE_FILE variable to reference multiple files.

It's strongly recommended that you keep a copy or link (on UNIX of the license file in the vendor's default location, so that you don't need to set AGILEESOF_LICENSE_FILE to run your applications.

The Application Program

The application program using FLEXlm is linked with the program module (called the FLEXlm client library) that provides the communication with the license server. During execution, the application program communicates with the vendor daemon to request a license.

The License Request Process

When you run a counted FLEXlm-licensed application, the following occurs:

1. The license module in the client application finds the license file, which includes the host name of the license server node and port number of the license manager daemon, lmgrd.

2. The client establishes a connection with the license manager daemon (lmgrd) and tells it what vendor daemon it needs to talk to.

3. The lmgrd daemon determines which machine and port correspond to the master vendor daemon and sends that information back to the client.

4. The client establishes a connection with the specified vendor daemon and sends its request for a license.

5. The vendor daemon checks in its memory to see if any licenses are available and sends a grant or denial back to the client.

6. The license module in the application grants or denies use of the feature, as appropriate.

Uncounted features (where the number of licenses is 0) do not require a server, and the FLEXlm client library routines in the application grant or deny usage based solely upon the license contents.
Configuring FLEXlm

Most of the parameters of FLEXlm are configurable by the license administrator. The license administrator can set:

- The location of the license file (though it's recommended that a copy or link of the license remains at the location where the application expects it)
- The location of all executables
- The location of all log files
- The TCP/IP port number used by the license manager process, lmgrd

In addition, the license administrator can reserve licenses for specific users, nodes, or groups, and control other license-related options.

The following sections provide a quick overview of how to set up and use licensing for FLEXlm-licensed products. By scanning the list, you should be able to quickly find the areas of interest.

Installing Licensed Software

As a license administrator you are responsible for setting up licensing on your system or network. This section tells you how to do that. If you are an end-user of the application and you will not be involved in installing it, refer to the section of this chapter, “Notes for Users” on page C-6

Remember that your specific Advanced Design System installation instructions in this manual give specific directions for installing and configuring FLEXlm for Advanced Design System.

Generally, installing FLEXlm licensing requires the following steps:

1. Select your license server nodes and get their hostids.
2. Give the hostids to your software vendor and get a license file (or the data to enter in the license file) in return.
3. Consider combining the new license file with any existing license files.
4. Determine if an options file is desired, and if so, set it up.
5. Determine where to install the FLEXlm utility programs such as lmgrd, and lmutil (lmsstat/lmdown/etc.) and install them unless your vendor's installation script does so for you.
6. Start lmgrd (the license daemon) manually. You may also want to set it up to start automatically at boot time.

License Servers and Hostids

Before running any FLEXlm-licensed program using floating licenses, you will need to set up your license server node (or nodes). You must select which node or nodes to run your license servers on, and provide the hostid of those machines to your software vendor.

You can get the hostid of the server machine by running FLEXlm's lmhostid utility on that machine. If you don't have lmhostid, you can get the hostid of your machine by using the appropriate command as described in Appendix A of the FLEXlm documentation, accessible from the Web.

Using the hostid of your server machines your vendor will send you a license file that enables their application software.

License and lmgrd Files

Once you have received a license file from your vendor, you must install it on your system and start up the license manager daemon, lmgrd.

Your software vendor may have selected a default location for your license file. If not, you can use any location you wish.

Some vendors provide special scripts to start up the license daemon. If not, you can run lmgrd directly. To start lmgrd automatically at boot time, you will have to modify your system files.

Administration Tools

GLOBE trotter Software supplies administration tools to your software vendor. The vendor usually includes them with their product. The recommended location for the tools is /usr/local/bin but you can install them in a different location (or not at all). Agilent EEsOo installs lmutil to the directory $HPEESOF_DIR/licenses/bin.

Options Files

The options file controls various options such as reservations and time-outs of licenses. Most users run without an options file, but you may decide you want to use
Background Information on FLEXlm

some options. For example, many administrators use an option to limit the quantity and content of logged messages.

Notes for Users

As a user of a FLEXlm-licensed application, you may need to know a few things to use the system effectively. The main things you need to know are:

- How to tell an application which license file to use
- How to query the system to find out who is using a license
- How to specify a license file

The license file determines what features are available to a program. It also contains information telling the application how to connect to the license server.

To find out who is using a license, run lmstat with the following syntax:

```
lmutil lmstat -a
```

For more information, refer to the FLEXlm End Users manual, accessible from the Web at

Appendix D: Using Remote Simulation

Following are instructions for enabling and running remote Advanced Design System simulations using a UNIX client from which to start a remote simulation. Before starting the client process, it is necessary to first set up a server (host) computer on which to run remote simulations.

In this chapter, the term server has the same meaning as host or remote computer, and the term client has the same meaning as local computer.

Note These procedures are not exactly the same for the Momentum Electromagnetic simulator. For Momentum remote simulation, refer to Performing Remote Simulations in the Momentum manual.

Remote simulation with a UNIX client works among the following system pairs:

- UNIX to UNIX
- UNIX to Windows NT
- UNIX to Windows 2000

Note The LSF type of remote simulation is described in “Using LSF Remote Simulation” on page D-8 at the end of this chapter.

Setting up Your Simulation Server (Host) Computer

Setting up a UNIX Server

To prepare a UNIX Server (remote computer), perform the following steps:

1. Log in to the remote computer.
2. Set the HPEESOF_DIR, PATH and DISPLAY environment variables as you normally would when running Advanced Design System. See “Quick Installation” on page 1-4 for more information.

Note DISPLAY has to be set if you are running Agilent Ptolemy simulations.
Using Remote Simulation

with TkPlots in them. This allows the server to display the TkPlots on the client machine.

3. Set the TCP communication port in the UNIX server in one of the following ways:
   • The communication port can be manually hard-coded in the hpeesof.cfg file. This might require root or super-user privileges to make the change (ask your IT department to help you). Open the hpeesof.cfg file located in <ADS_home>/config directory and add the following line to it:
     
     EEDAEMON_SOCKET = 1537
     
     If access to the IT department is slow, then create a new hpeesof.cfg file in your <home>/hpeesof/config directory and add the above line to it.
     
     While this socket is generally not used, make sure 1537 does not appear in /etc/services file. If it does, then choose another number for the socket (e.g., 5332).
   • The eedaemon line in /etc/services provides the communication port to hpremote. (See “Setting up Your Simulation Server (Host) Computer” on page D-1 and ask your IT department for help on setting it up.)
   • If EEDAEMON_SOCKET variable is not set to any port, then by default port 1537 will be assigned to it.

Note: Momentum requires an additional line in the hpeesof.cfg file, which is:

MOMENTUM_SIM_PATH=<remote_computer_name>

Refer to Performing Remote Simulations in the Momentum manual for more information.

4. Run the following script on the server:
   
   hpremote -d /tmp/remote_sim.log
   
   The -d option is for debugging purposes. It allows you to see the screen messages and save them in the remote_sim.log file for later verification. This file will be stored in the /tmp directory.

   If you get an error message, see “Error Messages” on page D-6.

   To view the last part of the file, use the following command:
5. You can verify that the hpremote daemon is running by checking the process:
   ps -ef | grep hpeesofemx

   **Note** If another user has already launched the hpremote, then it must not be
   launched a second time. Subsequent remote users (you in this situation) can
   connect to this daemon as well. Make sure that the HPEESOF_DIR is set
   correctly for your simulation.

---

**Setting up a PC Server**

To prepare your PC server (remote computer) perform the following steps:

1. Set the TCP communication port in the server PC in one of the following ways:
   - The port can be manually hard-coded in hpeesof.cfg file. To do so, open
     hpeesof.cfg file located in `<ADS_home>`\config directory and add the
     following line to it:
     
     EEDAEMON_SOCKET = 1537
   - Or, create a new hpeesof.cfg file in c:\users\default\hpeesof\config directory
     and add the above line to it.

     If EEDAEMON_SOCKET variable is not set to any port, then by default,
     port 1537 will be assigned to it.

   **Note** Momentum requires an additional line in the hpeesof.cfg file, which is:
   MOMENTUM_SIM_PATH = <remote_computer_name>

   Refer to Performing Remote Simulations in the Momentum manual for more
   information.

2. Start the Remote Simulation daemon with the command:
   
   `<ADS_home>`\bin\hpremote -d remote_sim.log

   from an MS-DOS shell or from the Windows >Start >Run menu.
Using Remote Simulation

The -d option is for debugging purposes. It allows you to see the screen messages and save them in remote_sim.log file for later verification. This file will be stored in <ADS_home>/bin.

Note  Do not terminate the MS-DOS window that pops up. Doing so will immediately terminate the daemon as well.

The Server (remote) PC is now ready to run ADS simulations started on a client.

Setting up a UNIX Client (Local Computer)

It is recommended that you first edit the client's hpeesof.cfg file, located in the <ADS_home>/config directory to include:

```
EEDAEMON_SOCKET = 1537
```

Again, while this socket is generally not used, you should make sure 1537 does not appear in the /etc/services file. Also, even though 1537 is the default socket setting within ADS, best practices involve explicitly adding this line to the hpeesof.cfg file.

A client machine should now be ready to run remote simulation. Do the following:

1. Start ADS.
2. Open or create a project.
3. Open or create a design.
4. From the Schematic window, choose Simulate > Simulation Setup.
5. In the dialog box that appears, type in the Host name (or Host's IP address) in the Remote Simulation Host field.
6. Click on Simulate.

If Remote Simulation succeeds, the Status window will open and show the progression of the simulation.

Whether you need any other setup on the client depends on user preferences and if an OPEN_SIMULATOR error message occurs, see “Error Messages” on page D-6.
User Preferences

Multiple Servers

Multiple servers may be available on your system. Multiple servers are particularly useful when you intend to compare circuit simulation results as quickly as possible. Once multiple servers are set up, they can be accessed by typing in each name at a client computer, or by generating a listing on a client.

This listing appears when you click the down arrow next to the Remote Simulation Host field. Normally this is a list of one, defaulting to local and no others. However, you may write a list of hosts into the de_sim.cfg file on a client computer. Edit the de_sim.cfg file, located in your <ADS_home>/config directory, or c:\users\default\hpeesof\config (on PC) or <home>/hpeesof/config (on UNIX) directory, to include the following line:

SIMULATION_HOST_LIST=[hostname1] [hostname2]...

where each [hostname] must be separated by a single space. After making this edit, start ADS. From the Schematic window, choose Simulate > Simulation Setup. In the dialog box that appears, click the down arrow just to the right of the Remote Simulation Host field, highlight the host you want, and click the Simulate button.

Scripting

You may want to automate the startup of the EMX daemon each time the workstation boots. This can be done through a resource configuration (RC) script such as the following.

Example of RC Script

The following is an example entry to start hpremote setup:

HPEESOF_DIR=<your installation directory path>
PATH=$HPEESOF/bin:$PATH
if [ -f $HPEESOF_DIR/bin/hpremote ]; then
    hpremote -d /tmp/remote_sim.log & fi
Using Remote Simulation

Error Messages

Error Message 1
For either a PC or UNIX Server, if you get the following error message when running Remote Simulation on the client:

(send_server_command) OPEN_SIMULATOR
server error

there could be multiple causes, including:

The EMX daemon may not be running on the Server. Check the Server, as described next by operating system:

• **PC** Try using hpremote -d <filename> to start the daemon. If a failure re-occurs, you can check the log file <filename> saved in the <ADS_home>\bin directory to search for causes. On the client side, try typing in the Server’s IP address instead of its machine name in the Remote Simulation Host field of the box that pops up from Simulate > Simulation Setup.

• **UNIX** Please be sure you edited and ran hpremote as described above. Remember that adding EEDAEMON_SOCKET = 1537 to hpeesof.cfg is recommended before running hpremote.

• **PC and UNIX** If you are sure hpeesofemx is running on the Server, it may be listening to a different socket address than the client seeks. Please verify that both client and Server computers are using the same TCP socket. It is recommended to use socket 1537, the default setting in ADS sought by clients.

Error Message 2
For remote simulations using a UNIX server, if you receive an error message such as the following when running the hpremote script:

[1] + Stopped (tty output) -hpeesofemx-d remote.log &

this might be an indication that you are running from a shell that does not write messages to tty for a background process (tty gets the terminal name).

In this situation, use the following command in the hpremote script:

hpeesofemx 2>&1 &
Note that this message also appears if you are using remote simulation with Momentum.

**Ending Remote Operation**

It is recommended that you end the remote simulation process or task on the server once a remote simulation is done. To end a remote simulation process do the following:

1. On the local machine, exit Advanced Design System.
2. Terminate the hpeesofemx daemon that is running on the remote server. In Windows, go to the Task Manager and End the Process.
   
   In UNIX, to find the process do:
   
   ```bash
   ps -ef | grep hpeesofemx
   ```
   
   and then kill the process as follows:
   
   ```bash
   kill -9 <process ID>
   ```

   The next time Advanced Design System is launched, it will default to simulate locally again.

**Remote Simulation Restrictions**

Please note that the following restriction applies to remote simulation:

In the Momentum simulator, if a substrate computation is required, you must set the `<ADS_home>/momentum/lib/substrates` directory and the files under it accessible for reading and writing. However, if you do not do this, the program will warn you.

**Defining the EMX Daemon Remote Address**

Remote simulation requires fixed socket addresses for the client(s) and server(s) computers. By default, the EMX daemon started by the hpremote script uses a socket address of 1537. However, relying on this default setting may or may not result in a successful remote simulation. Thus, it is recommended to explicitly set the socket address by one of the two options below:

- Edit the `<ADS_home>/config/hpeesof.cfg` file for each client(s) and server(s) computer (PC or UNIX) to include:
Using Remote Simulation

**EEDAEMON_SOCKET = xxxx**

where xxxx is a port number not in use by the /etc/services file or the Windows Services (for instance xxxx could be “1537” if that port is free). This socket address should be known and fixed across all associated platforms (client(s), host(s)...).

- Edit the /etc/services file to set a socket address for EEDAEMON, such as
  
  `eedaemon xxxx/tcp eedaemon`

  where xxxx is a number such as 1537 or 5332. This method is useful in a multi-node environment. However, the /etc/services entry must be identical on every node. This approach has greater power, but requires root or super-user privileges to make the change. If access to a system administrator is slow, it may be overall easier to use the first option.

### Using LSF Remote Simulation

This section describes how to use LSF to perform remote simulations on one or more remote simulation servers.

LSF (Load Sharing Facility) from Platform Computing is a facility that enables remote simulations with dynamic host selection. ADS 2002 integrates this facility to enable automatic remote host selection. Simple swept simulations can also be configured to utilize many available machines on the network. We call this feature parallel simulation. A simple sweep can be setup to run on a set of machines. LSF is used to select the best machine set. Individual sweep points are run on each machine and results combined into a single dataset on the local machine.

For a machine to participate as a “fastest host” or in a parallel simulation it must have both LSF and ADS 2002 installed. ADS also needs configuration changes to tell it what hosts are available. The feature is configured using the status server configuration file, hpeesofsess.cfg.

### LSF Requirements

**Supported Operating Systems for Use as a Server (Host):**

- UNIX systems

**Supported Operating Systems for Use as a Client (Local Computer):**

- UNIX systems
• Windows NT

Supported LSF Software:
  • LSF Standard Edition 4.1

Where to Get LSF Software:
  • www.platform.com

Where to Get LSF Documentation:
  • www.platform.com/services/support/docs

---

**Note**  
LSF is used largely to determine suitable hosts for remote simulations. Many of the LSF features, like queuing and priorities, are unused in this release.

---

**Security**

Security is minimal. It is assumed that ADS and LSF are being used in a trusted environment. It is possible to accidentally use a different user's UNIX account when simulating.

**Recommendations For Use**

• For UNIX, all users (who will be using ADS and LSF) must have a common, shared, $HOME directory, on all systems. Note that, not only must the same $HOME directory name be used on all systems, but the same directory must be used (typically, the same directory is mounted via NFS in the same location on all systems). In other words, if a file in a user's $HOME directory is changed on one system, that change must be immediately reflected on every other system.

• It's strongly recommended that at least 100 MB of free disk space be available on each system for use by temporary simulation data (the more, the better).

• It's also strongly recommended that the disk space be on a local disk, as opposed to a network (NFS) disk. While network disks can be used, a significant simulation performance degradation can be seen if network disks are used. For best performance, the free disk space should be on a disk local to each system. This last statement is not in conflict with the requirement about $HOME directories. $HOME directories must be shared (and, therefore, be on a network drive), but temporary disk space should be on a local disk.
Using Remote Simulation

Setting Up LSF and ADS
To set up LSF with ADS, the following general steps are needed:

• Preliminary Setup
• Setting Up Scripts on Each LSF Remote Host
• Editing ADS Configuration Files
• Configuring Each ADS User
• Checking the User’s $PATH

Next, each of these five steps is described in detail.

Preliminary Setup
The following preliminary steps should be taken:

1. Follow the LSF instructions to set up LSF at your site. Note that LSF servers
   must be running on every system that you want to use as a possible simulation
   host. LSF clients must also be running on every system on which ADS will be
   running. If LSF is not running, ADS will not be able to perform LSF-managed
   simulations.

2. Install ADS on every UNIX system that you want to use as a possible LSF
   remote simulation host, and install ADS into the same location on each host (or
   use a symlink at the same location to point to where you actually installed
   ADS). Alternatively, you can install ADS on one or more centralized servers,
   and have each UNIX system access ADS via NFS and symlinks.

   All systems must be able to access ADS using the same directory path. Use
   symlinks, if necessary, to meet this requirement.

Setting Up Scripts on Each LSF Remote Host
Scripts on each LSF remote simulation host must be configured (if ADS is installed
on centralized servers, the following need only be done on each centralized server).
Do the following for each remote simulation host:

1. First, determine a location for a temporary work directory. The default is /tmp.
   You can use /tmp or /var/tmp, or some other convenient directory. However, you
   must have enough disk space at this location to hold the data for each
   LSF-managed intermediate simulation. It’s strongly recommended that this
location have at least 100 MB of free disk space. If you plan on performing large
simulations, you’ll need more disk space (the more, the better).

Again, it’s strongly recommended that the disk space be local; see above for
details.

Note that you do not have to use the same directory location on each LSF
remote simulation host. However, using the same directory location (using
symlinks if necessary) will greatly simplify configuration in the following steps.

For now, just make a note of this directory location. You’ll be using it in a later
step.

2. Copy the file, “$HPEESOF_DIR/sess/remote-sim-server”, to
“$HPEESOF_DIR/custom/config/remote-sim-server” (this destination file
should not already exist). Example:

```
cd $HPEESOF_DIR/sess
cp remote-sim-server ../custom/config/remote-sim-server
```

3. The newly copied file, “$HPEESOF_DIR/custom/config/remote-sim-server”, is a
plain shell script. Edit this file and appropriately change the settings of the
“HPEESOF_DIR” environment variable to match the correct HPEESOF_DIR
value for the current host.

You must explicitly set the value for HPEESOF_DIR. You cannot rely upon the
HPEESOF_DIR environment variable being properly set when this script is
run due to the way in which ADS executes this script.

(If the HPEESOF_DIR variable is set, it will have the value of HPEESOF_DIR
for the system on which the ADS graphical user interface is running. This may
not be the correct value for HPEESOF_DIR on the remote simulation host,
which is the host on which this script will be run.)

In this script, the default value for HPEESOF_DIR is “/dev/null”, which is
clearly incorrect; this value was chosen to emphasize the fact that this script
must be edited.

Note that this script allows different platforms (HP-UX, SunOS, and AIX) to
have different values for HPEESOF_DIR; make sure that you edit the correct
occurrence of HPEESOF_DIR for the current platform.

Note for HP-UX 11.xx only: If you do not have the HP-UX 10.xx compatibility
links installed, you must also change the first line of the newly copied file from
“#!/bin/sh” to “#!/usr/bin/sh”.

---

D-11
Using Remote Simulation

4. Make sure that the newly copied file has execute permission, for example:

   chmod 555 $HPEESOF_DIR/custom/config/remote-sim-server

**Editing ADS Configuration Files**

Next, on each LSF remote simulation host, one or more ADS configuration files must be edited (if ADS is installed on centralized servers, the following need only be done on each centralized server).

The configuration can be controlled on a system-wide or per-user basis. System-wide configurations affect all users on a system, but are simple to configure; only one file needs to be edited. Per-user configurations affect only a single user, and take precedence over any system-wide configurations; however, you'll have to configure a file for each user. You'll have to decide which is best for you. However, most users will be satisfied with a system-wide configuration.

1. To set a system-wide configuration, edit (create) the following file, and use steps 2 through 4 to set values in it:

   `$HPEESOF_DIR/custom/config/hpeesofsess.cfg`

To set the configuration for a single user, edit (create) the following file, instead, and use steps 2 through 4 to set values in it:

   `$HOME/hpeesof/config/hpeesofsess.cfg`

2. Next, add variables to one of the above files. Do the following:

   By default, LSF-controlled simulations will use all available LSF hosts for remote simulations, and every available host will be used for each simulation. For some sites, there may be issues with this:

   • This assumes that ADS is installed/available on all LSF hosts. Some sites may have ADS installed/available on only a subset of LSF hosts.

   To restrict simulations to a subset of LSF hosts, you must create a list of hosts to which LSF simulations may be submitted. See step 4 in this section, below, for instructions on how to set the LSF_HOSTFILE variable.

   • Some sites may want to limit the number of hosts that a single simulation can use.

   To limit the number of LSF hosts that a single LSF simulation will use, you must set the variable LSF_MAX_HOSTS. Example:

   `LSF_MAX_HOSTS = 17`
This will impose a limit of 17 hosts when performing a single LSF simulation. Note that this limit applies to each user’s simulation. For example, if two users have a limit of 17, and both perform LSF-controlled simulations, the maximum number of systems used is 34, and not 17.

If you need to limit both the hosts and the number of hosts, both methods can be used simultaneously.

3. You must tell ADS the location of the “remote-sim-server” script (from the section on scripts, above) on the remote systems. You do this by setting the variable REMOTE_SIM_SERVER.

Example: If you installed ADS on the remote systems such that HPEESOF_DIR=/ADS_170, you would add this line to the configuration file (without leading spaces):

   REMOTE_SIM_SERVER = /ADS_170/custom/config/remote-sim-server

Do not use any environment variables when setting this variable; you must use the actual, absolute path name. In other words, do not use a line such as:

   REMOTE_SIM_SERVER = $HPEESOF_DIR/custom/config/remote-sim-server

This will not work, and will only cause problems.

4. If you did not choose /tmp as the temporary work directory (for all systems) in step 1 in the section on scripts, above, you will have to tell ADS about this. If all systems will be using /tmp, you can skip this step.

You can specify a different temporary work directory for each remote simulation host, or you can specify that the same directory path is to be used on each host. If you want to specify the same temporary work directory path for all remote simulation hosts, you do so by placing a line like the following into the hpeesofsess.cfg file:

   LSF_TMPDIR = /my/tmp/dir

Replace /my/tmp/dir with the desired name of the temporary work directory. By setting LSF_TMPDIR, you are specifying that this directory path is to be used as the default temporary work directory on all remote simulation hosts.

If all systems will be using the same path specified by LSF_TMPDIR, you can skip the rest of this step.

If you need to restrict LSF simulations to a subset of LSF hosts, or if you want to specify different temporary work directory names for some or all of the
remote simulation hosts, you must create a file that lists each remote
simulation host and the corresponding temporary work directory (if different
from the default). However, if you create this file, note that only the systems
listed in this file will be used by LSF-controlled simulations.

This file is specified using the variable LSF_HOSTFILE. Example:

    LSF_HOSTFILE = /my/path/to/some/hostfile

This file can have any name, and it consists of text lines of the form:

    <system_name> [ <temporary_directory_name> ]

Where:

    <system_name> is the name of a remote simulation host, including domain
    name. In other words, the name must be a fully qualified domain name
    (FQDN).

    Note that all systems must be within your local domain (the same domain as
    the system from which ADS is run). You cannot specify systems that are not
    within your local domain. If you do, ADS may not work properly.

    <temporary_directory_name> is the optional name of the temporary
directory to use on the remote simulation host. If this directory is not
specified, the value of LSF_TMPDIR will be used, or, if LSF_TMPDIR is not
set, / tmp will be used.

Example (assuming that your domain name is “qptzx.com”):

    system1.qptzx.com /tmp
    system2.qptzx.com /disk2/tmp
    system3.qptzx.com
    system4.qptzx.com /some/disk/foo

Note that system3 does not have an explicit temporary directory; since one is
not specified, the value of LSF_TMPDIR will be used or, if LSF_TMPDIR is not
set, / tmp will be used. As only four systems are specified here, the maximum
number of LSF-controlled simulations is four (even though there may be more
LSF-managed hosts available).

As mentioned above, only the systems listed in this file will be used for
LSF-controlled simulations, and so you must insure that all systems that you
want to use are listed here.

Also, make sure that all temporary working directories are writable.

The following is an example of an lsf_hosts.cfg file:
Using LSF Remote Simulation

Configuring Each ADS User

Each user running ADS needs to be configured. Basically, each user needs to use a different port number for LSF-controlled simulations, and this port number must be manually chosen, and manually checked to insure that the port number is not being used by any other user.

Note that the port number must be unique. If two or more users share the same port number, it’s quite likely that one user will end up performing LSF simulations as another user.

Once the port number is chosen, the rest of the procedure is simple. For each user, from a shell prompt, do the following:

```bash
mkdir -p $HOME/hpeesof/config echo "EEDAEMON_SOCKET=12345" >> $HOME/hpeesof/config/hpeesof.cfg
```

Replace “12345” with the chosen port number.

Checking the User’s $PATH

Before running ADS, the path to the LSF programs must be in each user’s $PATH. To verify that LSF is in $PATH, you can run the lshosts command as a test, for example:
lshosts

Here, lshosts should print a list of available LSF-managed hosts.

Using LSF in ADS

For information on how to use LSF simulations within ADS, refer to Chapter 8 in the User’s Guide.
Index

C
codewords
  installing, 4-1

F
FLEXlm
  background, C-1
  options file, B-1
  FLEXlm licenses
    setting up, 4-1

G
guidelines
  pre-installation, 1-1

I
install
  unix, 1-1
installation
  custom, components, 3-5, 3-6
  full procedure, 3-1
  requirements, 2-1
  to multiple disks or directories, 3-14
  interface cards
    HP-IB, GPIB, 2-5

L
licenses
  setting up, 4-1
  special needs, 4-14

M
memory
  checking, 2-6

O
operating system
  checking, 2-8
  patches, 2-2
  requirements, 2-1

P
printing and plotting, setting up, 5-1

Q
quick installation, 1-4

R
remote simulation, D-1

S
starting ADS, 3-13

T
technical support, contacting, A-7
  troubleshooting, A-1